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Proposal Checklist

* Read relevant documentation (CfP, Guide, Primer, etc.)

* Create an ALMA account by registering at the Science
Portal (almascience.org)

* Download the Observing Tool (OT) & related guides
* Prepare the Science Case
* Note the new capabilities for this cycle!

* Prepare Science Goals (sources, frequency & correlator
setup, integration times) within the OT

* Make use of the Helpdesk & the Knowledgebase
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Documentation

-

-

e Call for Proposals (CfP)
* ALMA Primer

* OT Guide

* ALMA Tech Handbook

* Helpdesk Knowledgebase

J

Observing with ALMA

A Primer for Early Science




Downloading the ALMA OT

Associated
Universities, i

Atacama Large Millimeter/submillimeter Array

osmic Origins

Nk
'\; About  Science Observing Data Processing Tools { Documentation Help Jo)

Observing Tool

The ALMA Observing Tool (OT) is a Java application used for the preparation and submission of ALMA Phase 1 (observing proposal) and Phase 2 (telescope runfiles for accepted proposals) materials. It is also used for
preparing and submitting Director's Discretionary Time (DDT) proposals. The current Cycle 7 release of the OT is configured for the present capabilities of ALMA as described in the Cycle 7 Call For Proposals. Note that in
order to submit proposals you will have to register with the ALMA Science Portal beforehand.

Download & Installation

The OT will run on most common operating systems, as long as a 64-bit version of Oracle Java 8 is instafed (see the troubleshooting page if you ai experiencing Java problems) and is unlikely to work with higher

versions of Java. The tool is available in two flavours: Web Start and tarball.

The Web Start application is the recommended way of using the OT. It has the advantage that the OT is automatically downloaded and installed on your computer and it will also automatically detect and install updates.
However, Web Start has been removed from Java 11 and bugs were present in Java 9 (and maybe 10). If problems are encountered with the Web Start version, then the tarball installation is available.

The tarball version must be installed manually and will not automatically update itself, although it will indicate if an OT update is available for download. It is in general though less prone to installation problems than Web
Start.

Webstart Tarball

Using webstart is easier and has the
advantage that it checks for and will

Documentation A

Extensive documentation is available to hel download a hewer version at Startup

= If you are a novice OT user you should sta ration.

= Audio-visual illustrations of different aspects of the OT can be found in the OT video tutorials. These are recommended for novices and advanced users alike.

= More in-depth information on the OT can be found in the User Manual, while concise explanations of all fields and menu items in the OT are given in the Reference Manual. These two documents are also available
within the OT under the Help menu.

Troubleshooting

If you have problems with the installation and/or startup of the OT, please see the troubleshooting page. A list of currently known bugs, their status and possible workarounds can be found on the regularly updated known
OT Issues page. A further source of information is the OT section of the ALMA Helpdesk Knowledgebase - this contains a number of articles that deal with frequently-asked questions. After exploring these resources, if
confusion over some aspect of the OT remains, or if a previously unidentified bug has been uncovered, please file a Helpdesk ticket.
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When the ALMA OT starts

Make sure it’s Cycle 7 OT

First you see this
%

Then you see this
O Startup Options

What would you like to do?
@ Create a new proposal
) Create a new DDT proposal :

2 Open an existing project from disk

(_' Retrieve a project from the ALMA science archive

[_| Do not show this message again

OK

Initialising Gui...




. E s B a 2 YT
[ NON ) ALMA Observing Tool (Cycle7 (test)) - Project

File Edit View Tool Search Help | Perspective 1

Proposal | Program | %|( Spectral |"Spatial | Project

Principal Investigator

Select Pl...
Main Project Information
[

Project |
Assigned Priority
Project Code

None Assigned

“|( validation | validation History rLog |

O A clean slate. From here, you can: \mm-m
« Start a new proposal

» Add blank Science Goals (SG)

* Load templates with example SG

Contextual Help

1. Please ensure you and your co-Is are registered with the ALMA
Science Portal

New

. Science
2. Create a new proposal by either: Proposal
@ Selecting File > New Proposal
@ Clicking on the icon in the toolbar Click on the overview steps to view the contextual help

# Or clicking on this link

3. Click on the & proposal tree node and complete the relevant

P
Enn%unlng
fields.

Template
Library

Exporting




ALMA Observing Tool (Cycle7(2018dec-20190121)) - Project

ile Edit View Tool Search Help

0B E8E @00 L BEe G0 e

Proposal [ Program

{

9w Project
n

(] Planned Observing

This is the J-
tree and the
proposal node
is where you

*|( Spectral 'Spatial | Proposal |

Proposal Title
| Proposal cycle 2018.1

Abstra/

|| (max. 1200 characters)

provide a broad

description

We”ll move
down the node
of the J-tree in
the course of
these slides

| sud

Relal

’ Perspective 1

7

Proposal Type

\ ) Regular () Target Of Opportunity

O VLBl () Large Program

Scientific Category
0 Cosmology and the High 0 Galaxies and Galactic 0 ISM, star formation and
Redshift Universe Nuclei astrochemistry

Circumstellar disks,
(0 exoplanets and the solar
system

Stellar Evolution and the
Sun

Please select one
|| or two keywords

| Prev

[1»




ALMA Observing Tool (Cycle3-RC2) - Really catchy title here

; File Edit View Tool Search Help Perspective 1
[8]a[a]s] [<]] [=[=] (@
Project Structure : Editors
" Proposal t Program | ‘v [ Spectra ]"n:;-m l Proposal I
‘ @ Cosmology and the High - Galaxies and Galactic ~ ISM, star formation and |
¢ [ Really catchy title here : ~ Redshift Universe " Nuclei " astrochemistry
¢ @ Proposal g Circumstellar disks )
(=] Planned Observing : ) exoplanets and the solar gzerllar Evolution and the
B system

Lyman Alpha Emitters/Blobs (LAE/LAB) |~
: Lyman Break Galaxies (LBG) =
: :(rﬁx.o;dlieywordﬁ Starburst galaxies -
: Sub-mm Galaxies (SMG)

High-z Active Galactic Nuclei (AGN) =

e = on [
Further down, select PI/Co-I's from a\ B
search of registered ALMA users
and attach the Science Case from a

.pdf on disk

Science Case is a .pdf, max

4 pages including figures

8086 New!

Investigator search constraints In Cycle 7 the .pdf may not
AMAD L] 15 [nasze | contain more than 10% of its

Find Investgators_| '\ text in a font below 12pt

Type Full name Email Affiliatiol
PI Not set Not set Not set

Full name Email Affiliation ALMA ID
Harvey Liszt hliszt@nrao.edu North American ALMA ... |hliszt

Select PI l Cancel l i

\
rSelectPl... ‘ ‘ Add Col... j‘ l Add from Proposal... ‘

’ Attach...

T




Science Case

* Must include:
* Astronomical Importance
* Estimated intensity, S/N

* May include:
* Figures
* Tables
* References

* Free-form PDF document
* 12+ font, English only
* 10% of text or less in font below 12pt
e 20 MB file size
* 4 pages total (6 for Large Projects)

e



[ NON ] ALMA Observing Tool (FEB2017) - Project
File Edit View Tool Search Help Perspective 1

CICREIEIE aleae g -
Project Structure 4'|Editors

"Proposal I'quram 'ﬁ: "Spectral |'Spatial |"Proposal |

| »

Related Proposals

? 4w Project

¢
(3 Planned Observing

§§ Previous Proposals

Investigators
[2]
Type Full name Email Affiliation ALMA ID Executive
Pl Not set Not set Not set Not set Non-ALMA
‘ Add CoPI H Add Col H Remove Collaborator ‘ ‘ Add from Proposal ‘
cience (ase
cience Case (Mandatory, PDF, 4 pages max.) I Attach... | Detach | View... ‘
7 =

Observatory Use Only
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[ NON ) ALMA Observing Tool (Cycle7 (test)) - Project

File Edit View Tool Search Help | Perspective 1

0o s goe o n B @ -
4
Proposal | Program | Proposal ;
Cut #-X | -
Copy #-C | ?
Paste #d-V
2019.1
\8, New Science Goal
Clone node
Show Printable Summary of Proposal
Generate a PDF of Whole Proposal
\&] Display Project Time Summary
Expand all #-Z -
Collapse all ;
Find previous -1
Find next -1
Delete ®
Overview
Contextual Help Phase I: Science Proposal
lease ensure : our co-Is are registered with the ALM: - N -
1. l\_l 1 Ilil;wu.[..}nu ind your co-Is are registered with the ALMA New U Create validate Submit
_ =elence Torldl Science Y Stience Science Science
& ite a new proposal by either: Proposal J—p-’ Goals Proposal Proposal
@ Selecting File > New Proposal \ J
@ Clicking on the &8 icon in the toolbar Click on the overview steps to view the contextual help
@ Or clicking on this link T/ N ~ _
3. Click on the & proposal tree node and complete the relevant L;nngomng ’ [iebrpapr"i?te ] m%ﬁg gﬂze >
fields. Exporting /| Help? Steps
. A . Y
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ALMA Observing Tool (Cycle7(test)) - Project

File Edit View Tool Search Help

00 eaa =@

Proposal | Program |

SIEREIFEREIMPIAE]

| Perspective 1

( Spectral | Spatial | ScienceGoal (Science Goal) |

? ww Project
¢ [ Proposal
¢ [ Planned Observing
? % ScienceGoal (ScienceGoal (B6 12CO
[y General

General (Optional)

IC

2=

Science Goal Name [Science

| (B6 12CO (2-1) NGC3256 mosaic)

his
and
sa

[} Field Setup

a project to observe the nearby starburst galaxy NGC3256 in
in the emission line of 12CO (Z-1). As the source is extended a
will be used to cover the 30x30 area of interest.|

2=

: |

/

|| Resolve |

llar System Object? []

Name of bject|Unspeciﬁed I I

Parallax [0.00000 |

dinates

(SR A pont
System display?
RA | 0p:00:00.0000

I PM RA |0.00000 mas/yr |w

4]

/alidation History | Log |
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ALMA Observing Tool (Cycle6({UserTest)) - Casting Light on Chameleon's Dark CO

File Edit View Tool Search Help

0pedEseE 000 0 8ee @ -

(‘Spectral | spatial | Field Setup |

“Proposal | Program |

9w Casting Light on Chameleon's Dark CO
¢ [ Proposal
¢ [ Planned Observing
¢ | ScienceGoal (Chameleon's dark

[7) General
Field Setup
pectral Setup
Calibration Setup
Control and Performance
Technical Justification

| Perspective 1

< |

RA [arcsec] Dec [arcsec]
-0.00000 -0.00000
24.00000 26.00000
-12.00000 12.00000
20000.00000 -0.00000
I Add H Delete H Reset H Import || Export }

HI= ]
Source Name )1136-6827-0.4 | Resoive |
Choose a Solar System Object? [] Name of object |Unspeciﬁed | |
Sexagesimal Parallax [0.00000
_ System I:IZI display? [v]
Source Coordinates RA 11:36:02.0970 PM RA |0.00000 mas/yr |w
Dec -68:27:05.810 PM DEC |0.00000 mas/yr |w
Source Radial Velocity 0.000 km/s |~ 2[0.000000000 | Doppler Type [RADID |+
Target Type ® Individual Pointing(s) 1 Rectangular Field
Expected Source Properties
=
Peak Continuum Flux Density per Synthesized Beam |1.00000 =
Continuum Linear Polarization 4.0 per cent
Continuum Circular Polarization 0.0 per cent
Peak Line Flux Density per Synthesized Beam |0.10000 Jy Iv
Line Width 3.5 km/s | |
ar Polarization 0.0 per cent —
lar Polarization Percentage 2.0 per cent
H=
elative ) Absolute
c -

Add Source “ Load from File... H Export to File... “ Clone Source ” Delete Source H Delete All Sources

<1
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| Perspec

File Edit View Tool Search Help
8 3E = &k = HEHCOIR~ I I N
Project Structure 1'|Editors . i i
“Proposal | Program | " | Since Cycle 4, OT defaults to ICRS, the standard radio coordinate system
/ HIS|
H Resolve ‘

9 W Casting Light on Chameleon's Dark CO
¢ & Proposal
¢ [J Planned Observing
7 1% ScienceGoal (Chameleon's dark

Source name, position,

proper motion, velocity,

velocity rest frame. use
“Isrk” for v| gg

Rectangular
mosaic or 1/more
offset pointings?

/ The expected \

source properties

are used with the
spectral setup,
desired angular
resolution, rms,
to set the S/N,
dynamic range

and overall

/ Name of object ‘Unspecified

Parallax [0.00000 |Imas |w

Source Name J1136-6827-0.4

Choose a Solar System Object? []

\

kproject viability/
i I

[ »

Sexagesimal
Source Coordinates - 11:36:02.0970 PMRA [0.0¢ When you resolve a
5> Dec |-68:27:05.810 PMOEC 00t source name from the

server, check all the
returned info, some
may be junk

0.000 km/s |« ||lstk |« | z (0.000000000 | Dopple
‘@) Individual Pointing(s) C 1 Rectangular Field >

Peak Continuum Flux Density per Synthesized Beam (1.00000

Source Radial Velocity

Target Type

1 Continuum Linear Polarization 4.0 per cent
Continuum Circular Polarization 0.0 per cent

0.10000

Peak Line Flux Density per Synthesized Beam

Line Width

Line Linear Polarization 0.0 per cent
Line Circular Polarization Percentage 2.0 per cent

oordinates

Coord Type ® Relative

Polarization lower limits have
been made much simpler: 0.1% for linear

#Pointings 1 . . .
polarization and 1.8% for circular. These are
0.00000 now independent of correlator mode or

source extent.

-

Feedback

[ Validation | Validation History | Log |

0 errors, 1 warning : double-click on each row to be taken to the problem
[

[ { Nacrrintinn

Sunnactinn




Sexagesimal _I: Sexagesimal
System KRS B display? [v] System B display? [v]
RA F'CKRSS o001 Lon (deg) | 296.07092014
Dec J Lat (deg) | -6.59012369 |
0.000 |ecliptic v ||Isrk |w 0.000 km/s |w||lstk || :
horizon
® Indijazel ) (' 1 Rectar @ Individual Pointing(s) ' 1 Rectangul




ALMA Observing Tool (Cycle6({UserTest)) - Casting Light on Chameleon's Dark CO

File Edit View Tool Search Help

&l o

“Proposal | Program |

| Perspective 1

ale|el @ad -

spectral | Spatial | Field Setup |

9w Casting Light on Chameleon's Dark CO
¢ [ Proposal
¢ [] Planned Observing
2 i) ScienceGoal (Chameleon's dark

[7) General
[ Field Setup
D Spectral Setup
[T calibration Setup
[T} control and Performance
D Technical Justification

=[]

“ Resolve |

| »

Source Name |11135-582 7-0.4
Choose a Solar System Object? [] Name of object |Unspec'rﬁed | |

Sexagesimal Parallax [0.00000 |
RA 11:36:02.0970 PMRA 1000000 masm
N o5 810 PM DEC [0.00000 mas/yr |w

0.000 2 [0.000000000 | Doppler Type

@*d'widual Pointing(s) © 1 Rectangular Field

Source Coordinates

Source Radial Velocity

Target Type
Expected Source Properties

Coord Type ® Relative () Absolute

<

Offset Unit |arcsec |v|
#Pointings 4
RA [arcsec]
-0.00000 -0.00000
24.00000 26.00000
-12.00000 12.00000
20000.00000 élllegall -0.00096
l Add || Delete || Reset | Import || Export
Add Source | Load from File... “ Export to File... “ Clone Source | Delete Source




ALMA Observing Tool (Cycle6({UserTest)) - Casting Light on Chameleon's Dark CO

File Edit View Tool Search Help

&l o

“Proposal | Program |

ale|el @ad -

spectral | Spatial | Field Setup |

9w Casting Light on Chameleon's Dark CO
¢ [ Proposal
¢ [] Planned Observing

% %, ScienceGoal (Chameleon's dark

[7) General

[ Field Setup

D Spectral Setup

[T calibration Setup

[T} control and Performance
D Technical Justification

| Perspective 1

Source Name |11135-5827-0.4

Choose a Solar System Object? []

Source Coordinates

Expected Source Properties

HI=
“ Resolve |
Name of object |Unspec'rﬁed | |
Sexagesimal Parallax |0.00000 |
System I:IZI display? [v] -
RA 11:36:02.0970 o Lhul mas /yr
Dec  |-68:27:05.810 PM DEC I0.00000 mas/yr |w
Source Radial Velocity 0.000 km/s |+ 2[0.000000000 | Doppler Type [RADID |+
Target Type - ind'rvidual Pointing(s) © 1 Rectangular Field
(=

Coord Type ® Relative () Absolute

< |

Offset Unit |arcsec |v|
#Pointings 4
RA [arcsec]
-0.00000 -0.00000
24.00000 26.00000
-12.00000 12.00000
20000.00000 élllegal' -0.00000
l Add | | Delete | | Reset | | Import Export
Add Source | Load from File... “ Export to File... ” Clone Source ” Delete Source H Delete All Sources

| »

<1




riie  EQITL VIEW 1001 Jedrcn HEp [ s AL

peBee gaa ve o e aee Qo -
S
Proposal | Program | EE(SDECIFM [ spatial | Field Setup |

N

| »

Input source details and mapping info or use the Visual Editor on the spatial tab.
You must choose between checking 1 Rectangular Field on all sources or none.

¢l Project
¢ @ Proposal B ; ; ) .
Z| Check 1 Rectangular Field on the first source before adding others to put rectangular mosaics around multiple sources.

¢ [CJPlanned Observing 4
? \%) ScienceGoal (Copy of 34 Sources| ' ||"3)0426+2327-210-0.54 | aJ0439+3045-154-0.87 | aJ0445+0715-305-0.12 | aJ0510+1800-2990-0.33 |

[ General | a0231+1322-790-0.12 | aJ0242+41742-168-0.08 |  aJ0329+2756-195-0.20 |  aJ0356+2903-151-0.21
[ Field Setup| A" )0502+41338i-600-0.56 | aJ0203+1134-151-0.14 |  aJ0209+1352-413-0.09 | aJ0213+1820-161-0.13
[} Spectral Setup | )0437+42940i-224-0.98 | J0438+3004i-478-0.95 |  J0440+1437i-326-0.68 |  J0449+1121i-887-0.50
[} Calibration Setup | J0427+0457i-233-0.33 | J0437+2037i-245-0.53 | J0431+1731i-213-0.46 |  J0433+0521i-2178-0.30
[ Control and Performance || || J0403+2600i-327-0.20 | J0406+0637-330-0.28 | J0407+0742i-990-0.26 J0426+0518i-372-0.29
) Technical Justfication A" 10357+23195-170-0.18 | J0357+2319i-160-0.18 |  J0400+0550i-217-0.27 J0401+0413i-550-0.34

J0325+2224i-400-0.21 | J0329+3510i-254-0.27 |  J0334+0800i-331-0.39 |  J0336+3218i-1050-0.73

J0211+41051i-547-0.14 1 J0252+1718i-342-0.22

=k

«| Il | IC

4]




C A 10° limitation on O
source separation in a
Science Goal was
removed in Cycle 4. The
OT groups targets using
\hierarchical cIustering/

/The resulting clusters \
have a maximum
separation between
sources of 1° for long
baseline configurations
\_ and 10° otherwise Y,

C The resulting clusters N
and the configurations
that will be used to
observe them can be
examined along with the
\_ time estimate below -




Crafting mosaics

3 . " . - . T —————————" — ‘ | EI | gg ’
AgT Project - Observing Tool for ALMA, version Cycle2Test2 =
File Edit View Tool Search Help Perspective 1
éml e|m “REEERE
Project Structure : Editors . . .
( Proposal | | m - The Spatial tab gives a graphical
Unsgmitted Proposal : Mo iasts visualization of the Field Setup. PMRA |0.000[=
"] o
? Project
¢ & Proposal T R PM DEC [0.000
# [ Planned Observing Source Radial Velocity 2794.200 kmis | v ||hel |+ | z{0.009364291
? ScienceGoal (C#p
D General Target Type Individual Pointing(s) ‘® 1 Rectangular Field
D Field Setup Expected Source Properties ]
E] Spectral Setup
D Calibration Sef Peak Continuum Flux Density per Beam|0.17400 Jy |y
D Control and Pe
D Technical Justi Continuum Polarization Percentage 0.0
f Peak Line Flux Density per Beam 0.00000 Jy |y
Line Width 0.00000 kmi/s
Line Polarization Percentage 0.0
@ @ (=] @ [ [ 244139 12919.0 Rectangle
»\ | 10:27:56.867, -43:56:54.93 (J2000)
4 [ \ » Image Filename ~emijan\jsky3\cache\jsky9043341093951517820 fits .
= o Select a background image
Template library. Turn the keys o...[X FOV Parameters . .
¥ L TETTPTdE noTary. Turmume | o 2| [= from an onllne |mage server
¢ @@ Proposal Representative Frequency (Sky) 231.546 GHz E
v anned e Antenna Diameter ® 12m m
o- [ SCienCeGOal( = S enCamooe) U UuouuU Trarcsec |
o ScienceGoal ( Antenna Beamsize (HPBW) 26.706 arcsec
- ScienceGoal (B Show Antenna Beamsize v p length 2.00000 arcmin | -
o= ScienceGoal (B Image Query -
I ScienceGoal (B 7= q length 2.00000 arcmin | v» -
o~ B ScienceGoal (B Image Server Digitized Sky (Version Il) at ESO v Lo
o ScienceGoal (B o B Position Angle/0.00000 ‘ Eeg L
o ScienceGoal (B Image Size(arcmin) (10.0 Query . ~aina 1 -
nacinn g
o- 884 ScienceGoal (B q] m . & E o O
1 4 o —
== 2 ¥ ®
Overview 1 p
Contextual Heln Phase I Science Pronnsal 7




Crafting mosaics -

Editors
Spatial Field Setup
System [J2000 || 598 Parallax [0.00000 mas

So mash
f/Setting up the mosaic in the Field Setup \masff
S be |RI
1 Define the length, width and position angle
of the region to mosaic. Default is to
separate the field centers by about 48% of
the primary beam (the Nyquist rate).
\HPBW for the 12m antennas are 1.13)./D /

Line Width ’ 0.00000 kmis | »
- ) Line Polarization Pergentage 0.0 %
@& & (ml @[ 469175 13357.0 Ls‘ :
T T L_J_. ‘é{s’ X I s LU . Rectangle
’ 10:27:35.522, -43:56:25.99 (J2000)
Image Filename remijan\jsky3\cache\jsky9043341093951517820 fits Coords Type ) ABSOLUTE @ RELATIVE
FOV Parameters ystem J2000 =
2| [= Field Center E =
T Coordi S Dffset(Longitude) Im
Representative Frequency (Sky) 231.546 GHz Coordinates fiset(Longitude)0.00000 St ated
Antenna Diameter 8 12m 7m @ﬁqpmaﬂmpu 0.00000 number Of 7m
Antenna Beamsize (HPBW) 26.706 arcsec Array
Show Antenna Beamsize v arcmin

pointings

Image Query

q length 2.0 arcmin | w

Image Server Digitized Sky (Version |

Image Size(arcmin) |10.0 NO more than
150 12m Array
pointings.

Position Angle/0.00000 deg A




Crafting mosaics

i — ~— | |
RQT Project - Observing Tool for ALMA, version Cycle2Test2 == 28
File Edit View Tool Search Help Perspective 1
== 2 iy - "
A RIE ||l | @ You can load a local fits image
Project Structure : Editors
Proposal | 7 | Spatial | Field Setup |
Unsubmitted Proposal Spatial Image [ NGC3256 -~
v Project 21| source
¢ B Proposal
FPlanned Observing
! I? @ ScrenceGosl ;éop Source Name NGC3256
D General Choose a Solar System Object? Name of object|Unspecified
[7) Field Setup Sexagesimal
. ot SEXSgEs Parallax |0.000
[} spectral Setup System|JIGRSI ~ display? [v
D Calibration Set Source Coordinates RA 10:27:51. 6000 PMRA |0.000
[ Control and Pe Dec  |-43:54:18.000 PM DEC [0.000
[ Technical Justi
Source Radial Velocity 2794.200 kmis | v | |hel |w | z|0.009364291
Target Type Individual Pointing(s) ‘® 1 Rectangular Field
Expected Source Properties
Peak Continuum Flux Density per Beam|0.17400 Jy |y
Pl ’— » Continuum Polarization Percentage 0.0
= Peak Line Flux Density per Beam 0.00000 Jy |
Template library. Turn the keys 0...| X SRaSy pera !
Y L TETpTaE morary. TarmiumeTs o
¢ & Proposal Line Width 0.00000 kmis
Planned Observin
\ ? ScienceGo:I (g Q% Q% Q%] ’ Line Polarization Percentage 0.0
& & |\ & x 71,-52 0.0
o- [528 ScienceGoal ( Rectangle
> ScienceGoal fB | 10:28:13.821, -44:00:03.43 (J2000)
o ScienceGoal (B Image Filename ~emijan\.jsky3\cache\jsky9043341093951517820 fits Coords T:r'i'\@ ABSOLUTE @ RELATIVE
o ScienceGoal (B EOVParametors System J2000
o ScienceGoal (B
o= ScienceGoal (B o et(Longitude)0.00000 arcsec | Y
_@ et | You can turn on/off the mosaic beam pattern
o- [88 ScienceGoal (B~ "‘l‘q M N »
2l » =
Overview

Contextual Heln

Phase I Science Pronnsal




Crafting mosaics

AgT Project - Observing Tool for ALMA, version Cycle2Test2

SE| =

File Edit View Tool Search Help
= = | &l
Project Structure :

[ Proposal

Unsubmiited Proposal
? Eﬁ"r Project
¢ & Proposal

¢ [ Planned Observing
ScienceGoal (Cop
[ General
[y Field Setup
D Spectral Setup
[y calibration Set
E] Control and Pe
E] Technical Justi

<] ' »

Template library. Turn the keys o0...| X
Y L TETTPTaE morary. TarriumeTs o
¢ @@ Proposal
¢ [] Planned Observing
2l ScienceGoal (
ScienceGoal (
ScienceGoal (B
ScienceGoal (B
ScienceGoal (B
ScienceGoal (B
ScienceGoal (B
ScienceGoal (B
M ScienceGoal (B™
3

W?????‘????

-

Overview

LBl h 4

Editors
Spatial

Spatial Image
2

® @ =] @ [ x| 388 468
| 10:27:42.245 -43:51:24. 64 (J2000)
Image Filename ~emijan\.jsky3\cache\jsky9043341093951517820 fits

n

=\

Perspective 1

Or load a local fits image

on the pointing center

Each circle is the size of the hpbw, centered

[ NGC3256 -
Source
Source Name NGC3256
Choose a Solar System Object? MName of object|Unspecified
system| ICRS ¥ 5‘*_"335_5"”' Parallax |0.000
display? |
Source Coordinates RA 10:27:51. 6000 PMRA |0.000
Dec -43:54:18.000 PM DEC |0.000
Source Radial Velocity 2794.200 kmis |+ | |hel |+ | z|0.009364291 =
Target Type Individual Pointing(s) ® 1 Rectangular Field
Expected Source Properties
Peak Continuum Flux Density per Beam|0.17400 NI
Continuum Polarization Percentage 0.0
Peak Line Flux Density per Beam 0.00000 Jy |y
Line Width 0.00000 kmis
Line Polarization Percentage 0.0
Coords Type ABSOLUTE @ RELATIVE
Sﬁtenw J2000
Offset(Longitude)0.00000 arcsec |
T >

Contextual Heln

Phase I: Science Pronnsal




Tlhe spfectral 'setllJp has a visualizer for spect_ral w'ndows‘an_d speg:tra‘! Iir]ﬁi

File Edit View Tool Search Help

aa] [<]a) [o]a]

Perspective 1

ST IREI R ET
=

Proposal | Frooram |

Unsubmilted Proposal
¢ [& Project
¢ @@ Proposal
¢ [CJ Planned Observing
? . ScienceGoal (Copy of BE 12C0 (2-1): N
D General
[ Field Setup

[7) spectral Setup

Spectral Setup

[»

In the table below, itis possible to define up to 16 spectral windows,
Each baseband is 2GHz wide and can be separately configured i.e.
Mote that for bands 3, 4, 6, 7 and 8, itis not possible to put 3 basebal

e than

Leftiright click to zoom infout, grab sliding bar to pan

D Calibration Setup
D Control and Performance
[T} Technical Justification

Mote: Moving LO1 here is for experimentation only - actual setup determineg !I e windows
| |

19I]|EIEI | 2I]EI|I:IIJ 24EIII]IJ A 25EIIIJEI

.....

o

Drag the green slider to
slide the VIEW

move the first LO

1Click in the yellow area to
" MAGNIFY

190[00 200(00 240(00 250(00

Rest Freauency

q] i I

Template library. Turn the keys on the JTree below &r...
(Y L TETNpIdEe orary. TurT ime Keys orm e JTTEe UETY

Overlays: Receiver Bands [v] Transmission [ ] OverlayLines [v] DSB Image | Select Lines to Overlay |

Water Vapour Column Density: ® Automatic Choice ) Manual Choice |1.262mm (4th QOctile) | ‘

DX =

¢ @@ Proposal
¢ [J Planned Observing

ScienceGoal (B3 spectral sweep CO
ScienceGoal (B7 continuum: COSMO|
ScienceGoal (B7 CO(9-8). Cosmic Ey
ScienceGoal (B9 continuum: Cosmic
ScienceGoal (B3 spectral sweep: PKY |
ScienceGoal (B3 continuum: GRB To| ™|

Viewport: l Pan to Line Zoom to Band I Reset |

[

[4]

?

[Validation | Validation History | Log | Zoom in here to start

TYYYY

| Description | Suggestion I

Contextual Help _ PhasekScienceProposal




The spectral setup tab .

00 ALMA Observing Tool (FEB2017) - Project

= A & i T

File Edit View Tool Search Help |Perspective 1

0pee esE o000 - dee Y @

M
Proposal | Program | ' Spectral | Spatial | spectral Setup |
i Note that for bands 3 to 8, it is not possible to put 3 basebands in one sideband and the fourth one in the other. -
9 w Project . . . iy ||
¢ i@ Proposal Left/right click to zoom injout, grab sliding bar to pan

Note: Moving LO1 here is for experimentation only - actual setup determined by the windows
¢ I Planned Observing ng p ly p y

¢ (% ScienceGoal (Copy of Chagfleon's d
D General
[ Field Setup
[y spectral Setup
® [ calibration Setup
[ control and Performance
[ Technical Justification

Observed Frequency
o, |1§5|00 IPO OOI | |1|95100| | |2|0000| | ZJSJO?I‘I |2|1010| I |2|15100| | IZFOPOI I IZFSiOOI I |2§0|0C

Satetatatatetabatetatetatitel teletetatatatatatutatatututabuttabuttetet

__Lontipuum
__Lantinuum

__Lontipuum
Continuum

T Takslod T Tabolod T Tibslod T T2bolod T Thslod T T2holod T T2hslod T To2bolod T Tabslod T T Z0loc

Rest Freauency

when you click on
this node you will

land on its
visualizer tab

Overlays: Receiver Bands Transmission DSB Image [ | Spectral Lines | Select Lines to Overlay

Water Vapour Column Density: ® Automatic Choice ) Manual Choice |1.796mm (5th Octile) | |
Viewport: | Pan to Spectral Window I l Reset ‘

Spectral Type

) Spectral Line
Spectral Type (® Single Continuum
) Spectral Scan

roduce image sidebands (Bands 9 and 10 only) [ ]
Polarization products desired () XX @ DUAL O

Receiver Band |5 [163.0-211.0 GHz) v

\ Reset to Standard Frequency l

£hae T 2nz nnnnn_ | e

Il

4]




File Edit View Tool Search Help

Proposal | Program |

ALMA

[

pmo e e gao (-

Spectral

? L Project

¢ [ Proposal
¢ [[J Planned Observing
9 % ScienceGoal (Copy of Chameleon's d

D General
[} Field Setup
D Spectral Setup

[} calibration Setup
[y control and Performance
D Technical Justification

Baseband-1

Fractior|

Centre Freq

Spectral Line

ing Tool (FEB20

17) - Project

| Perspective 1

=

Spec/Representativg

(rest,Isrk) Avg. Window
1(Full) | 98.70000 GHz | 98.69607 GHz |continuum |1875.000 M| [
Add spectral window centred on a spectral line | | Add spectral window manually | Delete [ Show image spectral windows
Baseband-2
1/2 97.99517 GHz | 97.99127 GHz |I-C3H v=0 )=9...| 58.594 MHz( 179 km/s). 557 kHz( 0.216 km/s) 2 [
1/2 97.98095 GHz | 97.97705 GHz |CSv=0 2-1 58.594 MHz( 179 km/s), 035 kHz( 0.187 km/s) 1 [
Add spectral window centred on a spectral line | I Add spectral window manually | | *ete | [] show image spectral windows
Baseband-3
1/2 86.67076 GHz | 86.66731 GHz |HCO 1(0,1)-0(... | 58.594 MHz( 203 km/s), 6 ‘HZ( 0.211 km/s) 1 [
1/2 87.31690 GHz | 87.31342 GHz |CCHv=0 N=1-...| 58.594 MHz( 201 km/s), 6 "IZ( 0.210 km/s) 1 (=]
spectral window centred on a spectral li Add spectral window manual lete [] Show image spectral windows
1-0 | § 1 O]
-0 |5 1 |
Add spe ctral windows

Representative Frequency

The representative frequency is used in conjunction with the sensitivity entered on the 'Control and Performance' page to estimate the required
observing time and to set the size of the antenna beam shown in the 'Spatial Visual' editor. If the transition you are most interested in does

|»

[

4]




The spectral line picker has new filters

Create spectral windows centred on spectral lines

&

DR R |

Transition Filter

I,

Transitions matching your filter settings:

(double-click column header for primary sort, single-click subsequent columns for secondary sorting. Single clicks will reverse sort order of already selected columns.)

e.0. CO"2-1" or “oxide”
¢ o Transition = Description Rest Freque... | Sky Frequency |Upper-state Ene..| Lovas Inten... Sij p? Catalog
Include description C13CH N=1-0, J=3/2-1/2, F1=1-0, F=3... |Ethynyl 85.256952 GHz [85.254936 ... |4.092 K 0.07/0.754 D*  |Offline |=
; t-CH3CH20H 6(0,6)-5(1,5) trans-Ethanol 85.265503 GHz (85.263486 ... |17.483 K 0.25/5.343 D*  |Offline
Frequency Filters CH3CN v8=1) =9-8, K = -1 --3 Methyl Cyanide 85.267374 GHz (B5.265357 ... |585.474 K 0.001 D* |Offline |=
ALMA Band H2CO 50(6,44)-50(6,45) Formaldehyde 85.310678 GHz (85.308661 ... |4881.916 K 6.63 D* Offline ||
m CC13CCH N=9-8, J]=19/2-17/2, F1=17/... |1,3-Butadiynyl radical 85.331915 GHz (85.329897 ... |20.474 K 0.036.372 D*  |Offline
T | | | | CC13CCH N=9-8, J]=19/2-17/2, F1=19/... |1,3-Butadiynyl radical 85.331917 GHz (85.329898 ... |20.473 K 0.03|7.12 D* Offline
1 2 3 4 5 6 7 8 10 |CC13CCH N=9-8, J=19/2-17/2, F1=19/... |1,3-Butadiynyl radical 85.331935 GHz (85.329916 ... |20.473 K 0.03|7.888 D*  |Offline
CC13CCH N=9-8, J]=19/2-17/2, F1=17/... |1,3-Butadiynyl radical 85.331936 GHz (85.329918 ... |20.473 K 0.03(7.138 D*  |Offline
Sky Frequency (GHz) ¢-HCCCH v=0 2(1,2)-1(0,1) Cyclopropenylidene 85.338893 GHz |85.336875 ... [6.445 K 3.1/52.945 D? |Offline
@I ; — : —— ; ; HCS+ 2-1 Thioformylium 85.347869 GHz (85.345850 ... |6.143 K 0.4/7.668 D*  |Offline
prrrrerrr ettt IcH30H vi=1 . > [offline
Min H Max H [u-85396 Offline
CH3CCH v=0 Offline
Receiver/Back End Configuration CH3CCH v=0 Offline
3 Al lines CH3CCH v=0 Offline
_ , CH3CCH v=0 Offline
® Potentially selectable lines U-85468.3 - R - Offline
(2 Lines in defined spws U-85486.6 UNIDENTIFIED 85.486600 GHz (85.484578 ... 0.22 Offline
- RS- _7 i 2 i
@ Filtering unobservable lines CH3CN vB8=Q ] =65-65, K =2-0 Methyl Cyanide 85.489615 GHz (85.487593 ... |2424.382 K 0.675D Dfﬂ!ne
U-85492.6 UNIDENTIFIED 85.492600 GHz (85.490578 ... 0.18 Offline
U tate E K) CH3C4H 21(g)-20(1) Methyl diacetylene 85.497333 GHz (85.495311 ... |55.32 K 58.628 D* |Offline
pper-state Energy ( CH3C4H 21()-20(0) Methyl diacetylene 85.498166 GHz |85.496144 ... [47.402 K 0.158.699 D* |Offline
Min l OH' Max | O'il U-85499.3 UNIDENTIFIED 85.499300 GHz (85.497278 ... -0.1 Offline
CH3CN vB8=1f§ =39-39, K =3-1 Methyl Cyanide 85.500670 GHz (85.498648 ... |1239.893 K 0.15 D* Offline
Molecule Filter / Environment CH30H vt=1Q2(8,14)-22(6,16) Methanol 85.501157 GHz (85.499135 ... |1180.751 K 0.043 D*  |Offline |
LLRSSNE LININEMTICIED S CNEANN CL> I8 CAIATE ni f\mnnn_.:
Show |all atoms and molecules |v| Add to spectral window list
B T ittt ittt I R R R A R R R R R R R R e e i R R e R e e e i R R R e e e e e R R R R e R e R e R R e R A R R A R R R R A A R R R R A R A
Spectral winddws in this baseband (maximum of four,
Can't find the transition you're looking for in pect \ )
the offline pool? Find more in the online ransition < Description Rest Frequency <~ Sky Frequency
Splatalogue. U-85468.3 UNIDENTIFIED 85.468300 GHz 85.466279 GHz
| Search Online I
| Reset Filters I
Remove spectral window(s)
| Lo |




Create spectral windows centred on spectral lines

Transition Filter &

B |

8.g. CO"2-1" or “oxide”
Include description =
L)

: CH3NHZ 4(1)A2-4(0)AL, F=5-5 -

Frequency Filters CH3NH2 4(1)A2-4(0)A1 - 9 GF . 125.40 i 0 T
ALMA Band CH3NHZ 4(1)A2-4(0)A1, F=4-4 Methylamme 86.075367 GHz |86. 073331 ... |25.405 K 2.193D° |Offline
n SO 32 v=0 2(2)-1(1) Sulfur Monoxide 86.093950 GHz |86.091914 ... |19.314 K 1.7]3.534 D7 |Offline
A 86.107150 ... |43.712 K 0D’ Offline
1 2 3 4 5 6 7 8 86.109483 ... |109.97 K 0.007 D |Offline
86.131163 ... 0.5 Offline
Sky Frequency (GHz) 86.145963 ... 0.5 Offline
“.@. T — = . Hz [86.149562 ... 0.6 Offline
prrtrr ettt bt 3CH30H vi=1 5(3,3)-6(2,5) Methanol 86.168150 GHz [86.166112 ... [451.624 K 0.162 D |Offline
Min H Max H | _[23345K 1.6 Offline
0.9 Offline
Receiver/Back End Configuration | 0.9 Offline
O Al lines | [1227.895 K 7.175D° |Offline
@ Potentially selectable fines| BT 0'92994 = 82:::
) Lines in defined spws . . [8.357 K 5.709 D*  |Offline

- .

@ Filtering unobservable lines ? . 8.357K 0.2823.651 E) Ofﬂ!ne
CH30CH3 2(2,0)-2(1,1) AA 86.226681 ... |8.357 K 8.981D° |Offline
ioperstate E ‘ . 86.237560 ... 1.7 Offline
pper-state Energy (K) 86.241330 ... |1775.339K 17.4]19.495 D* |Offline
Min | 0f Max | 86.241460 ... 1.6 Offline
86.246160 ... 0.8 Offline

. . 86.252808 ... |716.792 K 0.6124.513 D? |Offline |—

MOIecu'e Fllterl EnVImnment LLEEI2E0 7 |IIMII'\EMTI[IEI'\ [QC 20700 CM= |86 23S TEEN N1 f\ﬂ]u.n_,:

Show |aII atoms and molecules |v|

Add to spectral window list

Can't find the transition you're looking for in
the offline pool? Find more in the online
Splatalogue.

\ Search Online |

l Reset Filters |

Spectral wmdows in thls baseband (maximum of four)

Transition =

Description

Rest Frequency £

Sky Frequency

our pseudo continuum

88.000000 GHz

87.997919 GHz

Remove spectral window(s)

|Cance|||0k|
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ALMA Observing Tool (FEB2017) - Project

File Edit View Tool Search Help | Perspective 1

SIEIEIEICREIFCRE M

Proposal | Program | Spectral | Spatial | Spectral Setup |

|»

Spectral Line

9 4w Project
¢ [ Proposal Baseband-1 =
¢ [J Planned Observing - T oo Ero
? @ ScienceGoal (Copy of Chameleon's d{ Fractio s sr (s y.bar = ansition
%ge;er;' i) | 98.70000 GHz | 98.69607 GHz |continuurge
ie tup

[} spectral Setup

[ calibration Setup

[ Control and Performance
| % Technica ification

Add spectral window centred on a spectral line | | Add sp:

97.99127 GHz |I-C3H v=0)=9...| 58.594 MHz( 179 km/s), 70.557 kHz( 0.216 km/s) Q
97.97705 GHz |CSv=0 2-1 58.594 MHz( 179 km/s), 61.035 kHz( 0.187 km/s) Q
ow centred on a spectral line | | Add sp
86.66731 GHz |HCO 1(0,1)-0(... 1 [
87.31342 GHz |CCH v=0 N=1-... 1 [
I Add spectral window centred on a spectral line | | Add sp al windows |
Baseband-4
[1/2 ] ss 63160 GHz ] ss 62807 GHz ]HCN v=0)=1-0 | 58.594 MHz( 198 km/s), 61.035 kHz( 0.206 km/s) 1 |w
= Hz 1 =01.0 | 58.594 MHz( 197 km/s), 61.035 kHz( 0.205 km/s) 1 o
pectral window manually l | Delete | [] Show image spectral windows
the sensitivity entered on the 'Control and Performance' page to estimate the required
shown in the 'Spatial Visual' editor. If the transition you are most interested in does
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ALMA Observing Tool (FEB2017) - Project

File Edit View Tool Search Help

CIRICIERCIEE

("Proposal | Program |

L

“

EINEREIR

? i Project
¢ [ Proposal
¢ [ Planned Observing
? % ScienceGoal (Copy of Chameleon's d
[ General
[ Field Setup
D Spectral Setup
[ calibration Setup
[T control and Performance
D Technical Justification

Double click this fielc

“Spectral | Spatial | spectral Setup |

| Perspective 1

Polarization products desired XX @

Spectral Setup Errors
No suitable receiver band for the range :[0.0 GHz, 98.02251613655123 GHz]

Spectral Line

DUAL ) FULL

[2][=]
Baseband-1
Fractiorf Centre Freq Centre Freq - Spec)Representative
(rest,Isrk) (sky,bar) Transition ! Window
1(Full) | 0.00000 GHz | 0.00000 GHz |...Enter Name . 58.504 MH7. 30.518 kHz -
58. T
117.188 MHz, 61.035 kHz
234.375 MHz, 122.070 kHz
468.750 MHz, 244.141 kHz
| Add spectral window centre spectral line | | Add| 937.500 MHz, 488.281 kHz
1875.000 MHz, 976.563 kHz
seband-2 1875.000 MHz, 31.250 MHz
2 | 9 7 GHz |97.99127 GHz |I-C3H v=0)=9...| 58.594 MHz, 70.557 kHz 2 o
2 98095 GHz | 97.97705 GHz |CSv=02-1 58.594 MHz, 61.035 kHz 1 o
Add spectral window centred on a spectral line | | Add spectral window manually | | Delete | [[] Show image spectral windows
Baseband-3
1/2 86.67076 GHz | 86.66731 GHz |HCO 1(0,1)-0(... | 58.594 MHz, 61.035 kHz 1 [
1/2 87.31690 GHz | 87.31342 GHz |CCH v=0 N=1-...| 58.594 MHz, 61.035 kHz 1 [
Add spectral window centred on a spectral line I | Add spectral window manually | | Delete | [] show image spectral windows
Baseband-4
1/2 88.63160 GHz | 88.62807 GHz |[HCN v=0)=1-0 | 58.594 MHz, 61.035 kHz 1 O]
1/2 89.18853 GHz | 89.18498 GHz |HCO+ v=01-0 58.594 MHz, 61.035 kHz 1 [

| Add spectral window centred on a spectral line | | Add spectral window manually | | Delete

| [[] Show image spectral windows

| »




A B A A -
[ NON ] ALMA Observing Tool (FEB2017) - Project
File Edit View Tool Search Help | Perspective 1
0086 esu «oe o o o G-
<
Proposal | Program | o (“Spectral | Spatial | Spectral Setup |
. Polarization products desired =
9 4w Project
¢ [@¥ Proposal Spectral Setup Errors
¢ [J Planned Observing No suitable receiver band for the range :[0.0 GHz, 98.02251613655123 G
%\ ScienceGoal (Copy of Chameleon's d Spectral Line
[ General ==
[y Field Setup Baseband-1
Spectral Sety Fractioy Centre Freq Centre Freq - . . pec|Representative
SCI;“) _ 5: (rest,Isrk) (sky,bar) Transition Bandwidth, Resolution (smoothed) Avg. Window
fpration Setup L(Ful) | 0.00000 GHz | 0.00000 GHz |...Enter Name ... | 58.504 MH7__30.518 KkH7 |~ O
D Control and Performance 58.594 MHz, 30.518 kHz
D Technical Justification 117.188 MHz, 61.035 kHz
234.375 MHz, 122.070 kHz -
468.750 MHz, 244.141 kHz
Add spectral window centred on a spectral line I | Add| 937.500 MHz, 488.281 kHz
1875.000 MHz, 976.563 kHz
Baseband-2 1875.000 MHz, 31.250 MHz
1/2 97.99517 GHz | 97.99127 GHz |I-C3H v=0 )=9...| 58.594 MHz, 70.557 kHz 2 [
1/2 97.98095 GHz | 97.97705 GHz |CSv=02-1 58.594 MHz, 61.035 kHz 1 [
Add spectral window centred on a spectral line | | Add spectral window manually || Delete | [] Show image spectral windows
Baseband-3
86.67076 GHz | 86.66731 GHz |HCO 1(0,1)-0(... | 58.594 MHz, 61.035 kHz 1 [ L
B7.31690 GHz | 87.31342 GHz |CCH v=0 N=1-...| 58.594 MHz, 61.035 kHz 1 [
[] Show image spectral windows
1 |w
1 [©
m [] show image spectral windows




Full Continuum & Polarization LD r A4 A mm

[ NN ] ALMA Observing Tool (FEB2017) - Project
File Edit View Tool Search Help IPerspective 1
geee eac @ on o0 e G-
4
v

Proposal rProqram | Spectral | Spatial | Spectral Setup

| »

Spectral Type # Single Continuum

i Project
Moy ) Spectral Scan

¢ [ Proposal
¢ [CJ Planned Observing
% \% ScienceGoal (Copy of Chameleon's d
[ General
D Field Setup Spectral Setup Errors
[y Spectral Setup

Single Continuum
[} calibration Setup /

[ Control - Receiver Band |4 [125.0-163.0 GHz] v
[ Techn 3 [84.0-116.0 GHz]

Produce image sidebands (Bands 34nhd 10 only) []
Polarization products desired, (XX ) DUAL ®\EULL

5 [163.0-211.0 GHz]
Sky Frequency |6 [211.0-275.0 GHz]

7 [275.0-373.0 GHz]
Rest Frequency 145.000000 GHz

entre Freq - . :
sky,topo) Transition Bandwidth, Resolutio

00000 GHz |Single Continuum |1875.000 MHz( 4073 km/s), 62.500 MH

[] Show image spectral windows

Baseband-2
1(Full) |140.00000 GHz [140.00000 GHz [Single Continuum [1875.000 MHz( 4015 km/s), 62.500 MHz(133. m/s

[] Show image spectral windows

Baseband-3
1(Full) [150.00000 GHz [150.00000 GHz [Single Continuum [1875.000 MHz( 3747 km/s), 62.500 MHz(124.914 km/s) e

[[] sShow image spectral windows

Baseband-4

4




Full Continuum & Polarization

Al AA A BB

Standard single

continuum setups,
can be modified wi
justification

Full Polarization for

Bands 3 - 7
User can edit
frequencies used for
continuum polarization.
If FULL is specified, an
expected polarization
percentage must be
given with the field
setup tab

62.500 MHz(123.270 km/s)




Automated spectral scan - |

RQT Project - Observing Tool for ALMA, version Cycle2Test2

am (W] [@]e] o]

( Spectral rSpatial rSped[al Setup |
Unsubmited Proposal 2]=

File Edit View Tool Search Help

Bln| [¢]m] [c]a] @ *

Proposal | Froaram |

|

¢ & Project ) Spectral Line
! %S‘]D Pl : d Observi : Spectral Type ) Single Continuum
anne erving i -
¢ 8 ScienceGoal (Copy ® Spectral Scan
D General R~ ) —~
[ Field Setup Polarization products desired ) XX @ DUAL ) FULL
[} spectral Setup Spectral Setup Errors

[ calibration Setu
D Control and Perf
[Ty Technical Justifi

Spectral Scan

Requested start frequency (sky)

107.0 EIEI

95.8896 GHz - 108.0020 GHz

95.0 GHz-110.0 GHz

d)| 1875.000 MHz, 976.563 kHz | - |
K M
102.50000

The representative frequency defined in the observed frame is used in conjunction with the sensitivity gAtered on

the 'Control and Performance’ page to estimate the required observing time and to set the size of the/antenna beam shown in

the "Spatial Visual’ editor. The representative frequency defaults to the average mid-frequency of thf achieved scan range but may be
subsequently set by the user to any frequency within the achieved scan range.

ScienceGoal (|
ScienceGoal (B
ScienceGoal (B
ScienceGoal (B

PTYYTTPYTYYRY

Tuning (Max. 5) SPW 1 (GHz) SPW 2 (GHz)
ScienceGoal (B 1 95.9375 GHz 97.8125 GHz
ScienceGoal (B 2 99.6875 GHz 101.5625 GHz
ScienceGoal (B 3 103.4375 GHz 105.3125 GHz
ScienceGoal ( 4 107.1875 GHz 109.0625 GHz




Automated spectral scan - li

RQT Project - Observing Tool for ALMA, version Cycle2Test2

File Edit View Tool Search Help | Perspective 1
a/n [¢[a] [c]a] s @ (@) @] [0
J( Proposal | Froaram | l/ Spectral | Spatial | Spectral Setup |
Unsubmilted Proposal Visualisati |~
¢ & Project |
? & Proposal ctral windows, 4 per baseband as long as the total Fraction per baseband is no more than 1.
¢ [ Planned Observing onfigured i.e. each spectral window can have a different bandwidth and resolution.
¢ ‘ ScienceGoal (Copy b put 3 basebands in one sideband and the fourth one in the other.
D General
D Field Setup tual setup determined by the windows —
[) Spectral Setup Observed Frequency
[ calibration Setu 10 115[00
D Control and Perf
[} Technical Justifif | 2| = o e,
AL AL IS I A
A EA A SIS
A
< 1 | [» |
— Peson ' T " Taeolo’ "' Tasloo! & "oloo T T T Tragfon U7 T
Template library. Turn the keys on... |3| Rest Frequency
-~ ’ sl
¢ @ Proposal Overlays: Receiver Bands Transmission [] Overlay Lines [v] DSB Image | Select Lines to Qverlay l
¢ [ Planned Obsening ) : : )
o ScienceGoal (| Spectral Scan: Requested Scan Tuning 1 Tuning 2 Tuning 3 Tuning 4
o B ScienceGoal (B7|— Water Vapour Column Density: ® Automatic Choice ) Manual Choice ‘1.262mm (4th Octile) | I
o ScienceGoal (B
o= ScienceGoal (B Viewport: Pan to Line Zoom to Band l Reset |
o ScienceGoal (|
o= ScienceGoal (| Spectral Type
o ScienceGoal (B [z][=]
o ScienceGoal (B () Spectral Line
O=
T Spectral Type ) Single Continuum
o ScienceGoal (| =
o- 8 ScienceGoal (B6 v | | == = 2 Scan
« i [»]
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Saving spw & line rest frequencies A1 142 A B

ALMA Observing Tool (FEB2017) - Project

File Edit View Tool Search Help

eBee =s8u «on

Proposal | Program |

9 L Project
¢ [ Proposal
¢ [J Planned Observing

% \% ScienceGoal (Copy of Chameleon's d

D General

[} Field setup

[ spectral Setup

[ calibration Setup

[ control and Performance
D Technical Justification

4
K

I Perspective 1

v ale|e @ald -

[ Spectral | Spatial | spectral Setup |

-

Representative Frequency

The representative frequency is used in conjunction with the sensitivity entered on the 'Control a
observing time and to set the size of the antenna beam shown in the 'Spatial Visual' editor. If the
not fall in the centre of the chosen spectral window, its frequency can be changed here. The sky

shown in the targets table below.
152.00000

Rest Frequencies

Please set the rest frequencies of spectral lines that will be observed. Thes
to set the velocity scale and will enhance the ALMA Science Archive. We recgmm
once the spectral setup is fully defined.

| Define Rest Frequencies

Targets
=
Source Name | Velocity System | Representative Frequency (Sky)
1058-8003... 0.0/km/s |Isrk 152.0000 GHz
1136-6827... 0.0lkm/s [Isrk 152.0000 GHz
1145-6954... 0.0lkm/s [Isrk 152.0000 GHz
1147-6753... 0.0[km/s [Isrk 152.0000 GHz
1152-8344... 0.0lkm/s [Isrk 152.0000 GHz -
1224-8313... 0.0/km/s [Isrk 152.0000 GHz
B1251-713... 0.0[km/s [Isrk 152.0000 GHz
1312-7724... 0.0[km/s [Isrk 152.0000 GHz
1550-8258... 0.0lkm/s |lsrk 152.0000 GHz
1617-7717... 0.0lkm/s [Isrk 152.0000 GHz
1723-7713... 0.0lkm/s |Isrk 152.0000 GHz
1733-7935... 0.0[km/s [Isrk 152.0000 GHz =




Viewing spw & line rest frequencies 4! 41/ A B

[ NON ] ALMA Observing Tool (Cycle7(2018dec-20190121)) - Project
File Edit View Tool Search Help | Perspective 1

oeea =aa ©o B EIEEREIFMAC]

Proposal | Program | f Spectral [ Spatial | Spectral Setup |
Visualisation

? W Project
¢ [ Proposal In the table below, it is possible to define up to 16 spectral windows, 4 per baseband as long as the total Fraction per baseband is no more than
¢ [ Planned Observing Each baseband is 2GHz wide and can be separately configured i.e. each spectral window can have a different bandwidth and resolution.
% ) ScienceGoal (Copy of 34 Source Note that for bands 3 to 8, it is not possible to put 3 basebands in one sideband and the fourth one in the other.

[ General Left/right click to zoom injout, grab sliding bar to pan
D Field Setup Note: Moving LO1 here is for experimentation only - actual setup determined by the windows

[} spectral Setup Obsearved Frequency
[ calibration Setup |0000,
[T} control and Performance
[T} Technical Justification

HCO+ v=01-0
HCMNw=0]=1-0
2-1/2, F=2-1
CO 1w 1-000,0), |=342-1/4 F=2-1
H13CH+ 1-0
ﬁ H14GM v=0 |=1-0
LI-85486,
1-B4495 -85468,

loooo” ° " galoooor 7 seloooo’ T " sgsloo 000
Rest Freauencwy

Overlays: Receiver Bands Transmission DSB Image Spectral Lines | Select Lines to Overlay

Water Vapour Column Density: ® Automatic Choice ) Manual Choice |5.186mm (7th Octile) | *

Viewport: I Pan to Spectral Window | Zoom to Band I Reset |

Spectral Type

Spectral Setup Errors

Spectral Line
4]




Bands 9&10 - sideband separation (90° Walsh) » » » M

00 ALMA Observing Tool (FEB2017) - Cycle 5 Kelvin Sensitivity Test
File Edit View Tool Search Help
eea eac o000 0 aee @il -

¢

I Perspective 1

Proposal | Program | Spectral | Spayj
eft/rig| -
o CYCIE 5 Note: M
¢ [ Pro —
¢
o= “??(‘l( o, ?Il“( )(‘l( ')(‘651“?5{(0')(‘0)!)( )“(l‘)(‘ )‘l)l( )“?lioﬁioo
[
o=
o=
[
- =
! =

__bignal at 680 CHz __Bignal at 680 CHz

o' T T groloo" T T dzsloo” T ézoloo’ T T dssloo” T T aoloo!
st Freauency

oo T T dssloo” U7 deoloo’ T €

Overlays: Receiver Bands Transmission DSB Image [ | Spectral Lines I Select Lines to Overlay I

Water Vapour Column Density: ® Automatic Choice () Max

Viewport: Pan to Spectral Wind|

pectral Type

@ Spectral Line
) Single Continuum
) Spectral Scan

uce image sidebands (Bands 9 and 10 onfy)

Polarization p esired ) XX @ DUAL O FULL
pectral Setup Errors
pectral Line
==
Baseband-1
Fractiof Centre Freq Centre Freq - ) . Spec. Representativ,
(rest,Istk) (sky,bar) Transition Bandwidth, Resolution (smoothed) Avg. ImagJ Window
1(Full) |679.99934 GHz|680.00000 GHz Signal at 680 ... [1875.000 MHz( 827 km/s), 1.129 MHz( 0.498 km/s) 2 |®
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ALMA Observing Tool (FEB2017) - Project

File Edit View Tool Search Help

RGN

S |

Proposal | Program |

Sl

“

Spectral [ Sp Control and Performance

BEICCREIADT

9 hw Project
¢ [ Proposal
¢ [ Planned Observing

¢ % ScienceGoal (Copy of Chameleon's d
D General
D Field Setup
D Spectral Setup
[ calibration Setup

These parameters are used to control various aspects of the ol

Control and Performance

Configuration Informatiog
1.13*A /D) 12m 38.309 arcsec 7m 65.672 arcsec

ber of Antennas 12m 43 7m 10 TP 3

ACA 7m configuration Most compact 12m configuration Most extended 12m configuration

Longest baseline 0.049 km 0.161 km 16.197 km

\ynthesized beamsize 10.103 arcsec 2.906 arcsec 0.033 arcsec

0.009 km 0.015 km 0.256 km

47.725 arcsec 24.192 arcsec 0.409 arcse

Maximum recovera

Desired Performance
Desired Angular Resoll

Largest Angular Structure in source 0.00000
Desired sensitivity per pointing 0.00350 equivalent to 20.581 mK

Bandwidth used for Sensitivity |Aggregate8andWidth |v| Frequency Width  7.500000 GHz
Science goal integration time estimate
Override OT's sensitivity-based O Yes @ No

time estimate (must be justified)

Are the observations time-constrained? ) Yes ® No
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ALMA Observing Tool (FEB2017) - Cycle 5 Kelvin Sensitivity Test

File Edit View Tool Search Help

CRICIERCIEE

Proposal | Program |

CIEIEIEICHREIDIREA

LB
¥

o

Control and Performance

(M)

Spectral [ §

¢l Cycle 5 Kelvin Sensitivity Test
¢ [ Proposal
¢ [J Planned Observing
¢ \%j ScienceGoal (Range 1.05" .. 3" las

[ General
[ Field setup

D Spectral Setup

M Cai

| Control and Performance

]
9 \® ScienceGoal (Single at 1.053" las=|
D General
[} Field Setup
D Spectral Setup
[ calibration Setup
[ Control and Performance
[Ty Technical Justification
¢ % ScienceGoal (Single at 2" las=29")
D General
[} Field Setup
D Spectral Setup
[ calibration Setup
[ Control and Performance
[y Technical Justification
% \%j ScienceGoal (Single at 3" las=29")
D General
[} Field Setup
D Spectral Setup
[ calibration Setup
D Control and Performance
[ Technical Justification
¢ % ScienceGoal (Range 1.05" .. 2.63"
[ General
[ Field Setup
[ spectral Setup

[ calibration Setup
Gy e bt ek

4 Il »

| Perspective 1

These parameters are use

rol various aspects

Control and Performance

Configuration Information

Antenna Beamsize (1.13*A /D) 12m 65.288 ari

Number of Antennas 12m 43

ACA 7m configur,

Longest baseline 0.049 km
Synthesized beamsize
Shortest baseline 0.009 km

Maximum recoverable scale

Desired Performance

14.158 arcsec

75.610 arcsec

0.048 arcsec

3.882 arcsec

0.015 km 0.256 km

33.005 arcsec 0.568 arcsec

Desired Angular Resolution (Synthesized Beam) ( Single @ Range (> Any  Standalone ACA

Largest Angular Structure in source

Desired sensitivity per pointing

Bandwidth used for Sensitivity

1.05000 to [3.00000
29.00000
0.10000 EE equivalent to 721.13 uly

will provide 12.316 mK

@1.05 "

@3.00"

epresentativeWindowResolution |v| Frequency Width 0.141113 MHz




[ NN ] ALMA Observing Tool (FEB2017) - Project
File Edit View Tool Search Help Perspective 1
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Spectral [ Sp Control and Performance

LH
;

Proposal | Program |

These parameters are used to control various aspects of the observations, including the required antenna configurations and integration times.

9 W Project
¢ [ Proposal
¢ [ Planned Observing
9 % ScienceGoal (Copy of Chameleon's d

Control and Performance

2]

Configuration Information

D General Antenna Beamsize ( 1.13 *A /D) 12m
D Field Setup

[ spectral Setup Number of Antennas

D Calibra :

Longest baseline

Synthesized beamsize

Shortest baseline

Maximum recoverable scale

Desired Performance
Desired Angular Resolution (Synthesized Bea

® Single ' Range () Any () Standalone ACA
3.00000 arcsec | v

r‘ equivalent to 20.581 mK

Bandwidth used for Sensitivity |AggregateBandWidth |v| Frequency Width  7.500000™

Largest Angular Structure in source

Desired sensitivity per pointing 0.00350

Science goal integration time estimate
Override OT's sensitivity-based ) Yes @ No

time estimate (must be justified)

Are the observations time-constrained? ) Yes ® No
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ALMA Observing Tool (Cycle7(2018dec-20190121)) - Project name

File Edit View Tool Search Help

Proposal | Program |

9 W Project name
¢ fim

Perspective 1

opae eEee o000 s Bele G-

14
¥ -
%|( Spectral | Spati Control and Performance

Proposal

¢ [J Planned Observing

9 W% ScienceGoal (Copy of 34 Source
[ General

[ Field Setup
[ %
| Calibration Setup

[T} Technical Justification

These parameters are used to control various aspects of the observation es.

Control and Performance

Configuration Information
Antenna Beamsize ( 1.13 *A /D) 12m 8.260 arcsec

Number of Antennas 12m 43

ACA 7m configuration

Longest baseline 0.049 km

Synthesized beamsize 2.046 arcsec

Shortest baseline 0.009 km

Maximum recoverable scale 10.413 arcsec 4.77

Desired Performance
Desired Angular Resolution (Synthesized Beam) ) Singld «cm:,) ) Any () Standalone ACA

< [0.10000 0 [0.20000 | farcsec 2
Largest Angular Structure in source 1.00000 ’

Desired sensitivity per pointing 0.50000 Jy

Bandwidth used for Sensitivity |AggregateBandWidth

Override OT's sensitivity-based
time estimate (must be justified) 0 Yes ® No

Science Goal time estimate
(includes configuration and beam information) Line Esimate

Simultaneous 12-m and ACA observations ) Yes ® No

) Yes ® No

Are the observations time-constrained?
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File Edit View Tool Search Help IPerspectivel
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¢

Proposal | Program | Spectral |"Sp Control and Performance

These parameters are used to control various aspects of the observations, including the required antenna configurations and integration times.

9 lw Project
¢ [ Proposal
¢ [J Planned Observing
¢ % ScienceGoal (Copy of Chameleon's d
D General
[} Field Setup
D Spectral Setup

Control and Performance

2l

Configuration Information
Antenna Beamsize ( 1.13 *A /D) 12m 38.309 arcsec 7m 65.672 arcsec

Number of Antennas 12m 43 7m 10 TP 3

5 . ACA 7m configuration Most compact 12m configuration Most extended 12m configuration
| Control and Performance
AT e caton Longest baseline 0.049 km 0.161 km 2.517 km
Synthesized beamsize 10.103 arcsec 2.906 arcsec 0.236 arcsec
Shortest baseline 0.009 km 0.015 km 0.015 km
Maximum recoverable scale 47.725 arcsec 24.192 arcsec 3.555 arcsec

Desired Performance
Desired Angular Resolution (Synthesized Beam) ) Single ) Rand§ @ Any (_Jbtandalone ACA

Desired sensitivity per pointi

Bandwidth used for Sensitivi

Science goal integration time

Override OT's sensitivity-ba
time estimate (must be justifi

Are the observations time-constrai




[ NN ] ALMA Observing Tool (FEB2017) - Project

File Edit View Tool Search Help
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Perspective 1
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¥
Proposal | Program | %|("Spectral | Sp Control and Performance
9 i Project These parameters are used to control various aspects of the observations, including the required antenna configurations and integration times.
¢ [ Proposal Control and Performance

¢ [ Planned Observing
9 % ScienceGoal (Copy of Chameleon's d
D General
D Field Setup
[ spectral Setup

Configuration Information
Antenna Beamsize ( 1.13 *A /D) 12m 38.309 arcsec

Number of Antennas 12m 43

ACA 7m configuration

Longest baseline 0.049 km

Synthesized beamsize 10.103 arcsec
Shortest baseline 0.009 km

Maximum recoverable scale 47.725 arcsec

Desired Performance

Largest Angular Structure in source

Desired sensitivity per poi

Bandwidth used for Sens
Science goal integration t

Override OT's sensitivity
time estimate (must be j

Are the observations tim

Desired Angular Resolution (Synthesized Beam) () Single () Range () Any

7m 65.672 arcsec

7m 10
Most compact 12m configuration Mos
0.161 km 16.197 ki
2.906 arcsec
0.015 km 0.256

24.192 arcsec




Time Estimate

3dec-20190121)) - Project name

Note: Tk
Operati
is longe|
details.

Input P
Requested

Cluster 4 | Cluster 5 | Cluster 6 | Cluster 7 | Cluster 8 | Cluster 9 |

Bandwidth used for sensitivity 1.875 GHz
Representative frequency (sky, first source) 704.983 GHz
Estimated Total time for Science Goal 340 h

Cluster 1 I Cluster 2 I Cluster 3
Source Name RA Dec Velocity
0252+1718i-342-0.../ 02:52:07.7190 17:18:42.686 0.000 km/s
0)0242+1742-168-... | 02:42:24.2680 17:42:58.849 0.000 km/s
a)0231+1322-790-... | 02:31:45.8940 13:22:54.716 0.000 km/s

Perspective 1

7m 14.159 arcsec

7m 10

TP 3

S
—
=]
=

Most compact 12m configuration Most extended 12m configuration

Possible Configuration Combinations(

Max expected

LLg axial ratio

Nominal Beam(")

No 0.973863 x 1.10910 [1.5

Input Parameters
Precipitable water vapour (all sources)

0.472mm (1st Octile)

Time required for 12m (1) [C43-4]

Time on source per pointing (first source) 1.75 min [ 10.18 ms]
Total number of pointings (all sources) 3

Number of tunings 1

Total time on source 5.24 min [29.40 ms]

L[ 1] I-I-Iv e

0.10000 ﬂ to |0.20000 .

) Yes @ No

Total calibration time 15.60 min

Other overheads 1.97 min

Total time for 1 SB execution 22.80 min

Number of SB executions 1

Total time to complete SB 22.80 min

Calibration Breakdown per SB execution

2 x Pointing 4.00 min Ad
Close

Lo otal: 31938
- 0 ettt il T e




ALM

oG lime Estimates C e e

WA Observing Tool (2015.8) - D Disk Structure around Nearby Sun-like Stars (2015, @8 8 @ Time Estimate

File Edit View Tool Search Help

0o esu
“Proposal | Program |

Note: The time in brackets is that required to reach the sensitivity.

@ Operational requirements often mean that the actual observed time
is longer, especially for mosaics. Please see the User Manual for more
details.

FEICREINENE

Ll

Spectral | Spatial | Control and Performance |

Input Parameters

9 i Debris Disk Structure around Nearby Sun- These parameters are used to control various aspects of the observations, including t Requested sensitivity 0.01400 m)y
(&} §cien§e Plan Control and Performance Bandwidth used for sensitivity 7.500 GHz
¢ \% ScienceGoal (HD 10647) - generat Representative frequency (sky, first source) 230.52 GHz
[ General Configuration Information X . .
[} Field Setu ) Estimated Total time for Science Goal 6.02 h
P Antenna Beamsize ( 1.13 *A /D) 12m 25.260 arcsec 7m 43.
D Spectral Setup
[y calibration Setup Number of Antennas 12m 40 7m 10
% ?n:'rt?l alr;d P;frfo:nance ACA 7m configuration Most compa Input Parameters =
echnical Justification . .
! S_(%OUS (HD 10647) Longest baseline 0.049 km 0.157 km Precipitable water vapour (all sources) 1.796mm (Sth Octile)
¢ & Group OUS B i " )
0 Member OUS (HD_1064 Svnthes g Deam d 1.721 arcsec Time requ"'ed for C40-3 | |
¢ |M| HD_10647_a_06_TE P On souree pomung (first source) 1.44 h [1.43 h]
g Group 1 : Calibra Total number of pointings (all sources) 1
Group 2 : Science 5 arcsec Number of tunings 1
§ I 6 Targets - Total time on source 1.44h[1.43 h)
@® query Pointing S )
© query Pointing Total calibration time 49.50 min
© query Amplitul Other overheads 14.30 min
4] Il | [ Total time for 1 SB execution 1.25h
Cycle3 Template Library (read-only) :umlbér e exec'l:bor;sn s 51h
o B Cycle3 Temphte Lbrary otal time to complete .
[ Science Plan
Calibration Breakdown per SB execution =
o punovich - -
) 1 x SidebandRatio 1.58 min
Science goal integration time estimate Time Estimate & 1 x Amplitude 2.50 min
) 1 x Bandpass 5.00 min
Override OZ 6 x Phase 3.00 min
2 x CheckSource 2.00 min
Are the of 7 x Atmospheric 4.67 min
Calibration overheads 5.40 min
Additional Arrays ||
ACA - .40 3.51h
Total ACA time (max[t_7-m,t_TP)) 3.51h
Estimated total time for SB-1 ~ 6.02h =i

Close
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ALMA Obser

File Edit View Tool Search Help

ving Tool (2015.8) - Debris Disk Structure around Nearb

y Sun-lik 015, @ €

& e A jol B
Time Estimate

Proposal

Program

Spectral | Spatial | Control and Performance |

9w Debris Disk Structure around Nearby Sun

These parameters are used to control various aspects of the observations, including t

¢ [ Science Plan
9 % ScienceGoal (HD 10647) - generat
[} General
D Field Setup
D Spectral Setup
D Calibration Setup
[} Control and Performa
[} Technical Justification
I ﬁsc OUS (HD 10647)
¢ & Group 0US
¢ [ Member OUS (
¢ (] HD_10647 |
‘Group 1
Group 2
? @ 6 Targe
© que
© que
® query

(| Il

Cycle3 Template Library (read-only)

? lw Cycle3 Template Library
[ Science Plan

Control and Performance

Configuration Information

Antenna Beamsize ( 1.13 *A /D) 12m 25.260 arcsec

0.00001

AggregateBandWidth

Override OT's sensitivity-based time estimate (must be justified) C) Yes ® No

Desired sensitivity per pointing

Bandwidth used for Sensitivity

Science goal integration time estimate

) Yes ® No

Are the observations time-constrained?

Validation | Validation History | Log

| Description

stimated Total time for Science Goal 6.02 >

Note: The time in brackets is that required to reach the sensitivity.
Operational requirements often mean that the actual observed time
is longer, especially for mosaics. Please see the User Manual for more
details.

Input Parameters

Requested sensitivity 0.01400 mJy
Bandwidth used for sensitivity 7.500 GHz
Representative frequency (sky, first source) 230.52 GHz

I»

nput Parameters

Precipitable water vapour (all sources) 1.796mm (5th Octile)
ime required for C40-3

ime on source per pointing (first source) 1.44 h [1.43 h]

otal number of pointings (all sources) 1

umber of tunings 1

otal time on source 1.44h[1.43 h)

otal calibration time 49.50 min
Other overheads 14.30 min
Total time for 1 SB execution 1.25h

Number of SB executions 2

Total time to complete SB 2.51h

Calibration Breakdown per SB execution =
3 x Pointing 36.00 s

1 x SidebandRatio 1.58 min

1 x Amplitude 2.50 min

1 x Bandpass 5.00 min

6 x Phase 3.00 min

2 x CheckSource 2.00 min

7 x Atmospheric 4.67 min
Calibration overheads 5.40 min
Additional Arrays | |
ACA 7-m time (t_12m x 1.40) 3.51h
Total ACA time (max[t_7-m,t_TP]) 3.51h

Estimated total time for SB-1 6.02h

[«]

Close
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A Observing Tool (2014.6) - Bulge Asymmetries and Dynamical Evolution (BAaDE) (2013.1.01180.S last submitted 2014-11-14 17:52:31)

File Edit Vi

Tool arch Help

A Calibrator Selection Tool...

| Perspective 1

n (Isjouwer(@

elected Schedu

on -
e 0O 0O

Generate a PDF of Whole P @

tect

ScienceGoal (MSXiiiaRA16b1)
24 ScienceGoal (MSXiiiaRA16b2)

<]

i | [»

Template library. Turn the keys on the JTr...

¢ [= Template library. Turn the keys on th|~|
¢ (& Proposal

¢ [ Planned Observing

23l ScienceGoal (B3 spectral sy
ScienceGoal (B7 continuum
ScienceGoal (B7 CO(9-8): (
ScienceGoal (B9 continuum|=
ScienceGoal (B3 spectral sy
ScienceGoal (B3 continuum
ScienceGoal (B6 continuum
ScienceGoal (B7 continuum
ScienceGoal (B6 continuum
ScienceGoal (B3 continuum| |
ScienceGoal (B6 12CO (2-1

?

Total and Calibration Times

Use the the project time summary
button or Tool->display project time

summary on the main menu to see
these summaries per science goal

Science Goal 12-m Ext. 12-m Compact || 12-m Ext. + Compact [ ACA 7-m || ACA TP Overall Non-standard Mode
Tot. Cal. Tot. Cal. Tot. Cal. Tot. ||Cal. |[Tot. [[Cal. || Tot. Cal.
MSXiiiaRAl16al [[51.12 min(|24.75 min|| - - 51.12 min [[24.75 min |- - - - 51.12 min||24.75 min|(No
MSXiiiaRAl6a2 [|S1.12 min||24.75 min|[- - 51.12 min [[24.75 min |[- - - - 51.12 min||24.75 min|(No
MSXiiiaRA16a3 [|5S1.97 min||24.75 min|[- - 51.97 min [[24.75 min |[- - - - 51.97 min||24.75 min|(No
MSXiiiaRA16a4 ||51.12 min|(24.75 min|| - - 51.12 min ||24.75 min |- - - - 51.12 min([24.75 min||No
MSXiiiaRA16b1|/1.29 h 29.95 min||- - 1.29 h 29.95 min || - - - - 1.29 h 29.95 min|[No
MSXiiiaRA16b2 [[1.29 h 29.95 min||- - 1.29h 29.95 min |[- - - - 1.29 h 29.95 min||No
Overall 6.01 h 2.65h - - 6.01 h 2.65h - - - - 6.01 h 2.65h
Data Volumes and Data Rates
Science Goal Data Volume Data Rate
12-m ACA 7-m|[ACATP||12-m ACA 7-m|(ACA TP

MSXiiiaRAl6al ||54.85 GB |[- - 18.31 MB/s||- -

MSXiiiaRA16a2 [|54.85 GB ||~ - 18.31 MB/s||- -

MSXiiiaRAl16a3 [|55.77 GB ||~ - 18.31 MB/s||- -

MSXiiiaRA16a4 ||54.85 GB |[- - 18.31 MB/s||- -

MSXiiiaRA16b1|83.35 GB |[- - 18.31 MB/s||- -

MSXiiiaRA16b2 ||83.35 GB |[- - 18.31 MB/s||- -

Overall 387.01 GB||- -

ScienceGoal (B6 13CO (2-1
ScienceGoal (B6 spectral li
ScienceGoal (B9 spectral Ii:l
ScienceGoal (B3 continuum
ScienceGoal (B6 continuum|—

Comi Comml D2

PP YYYRYYY

l [ ]




Project Summary

Total and Calibration Times

|science Goal|| 12-m) | 12-m@ || 12-m+2) |[AcA7-m|AcATP | oOverall | Non-standard Mode|
[Tor. |[cal |[tor. |fcal. [fTor [lcal |Tot |[cal [[Tot|[cal|Tor |[cal || |
Atar 1"\ [1.03d|[6.21n[9.92 h|[2.48 h[1.45d|[s.70n|- |- |- |[- [[1.45 d|/8.70 n|[no |
Overall [1.03d|6.21n|[9.92 h|2.48 n|1.45d][8.70n]- |- |- [- [1.454d|s.70n]
Project Summary
Total and Calibration Times
| science Goall| 12-m (1) [12-m @ | 12-m (1+2) || ACA7-m [[ACATP | Overall |[Non-standard Mode|
|Tot. | cal. [[Tot. | cal. || Tot. | cal. [Tor. [lcal | 7Tot|[caLlfTor [lca. | |
At ar 3" [31.53 min||13.83 min|- |- |[31.53 min||13.83 min||2.63 h|[1.15n|- |- |/3.15 h|[1.38 n||No |
Overall 31.53 min|[13.83 min[|- |[- [[31.53 min|[13.83 min||2.63 h||1.15 n|[- |- [3.15n|1.38 ]

/ Especially when using RANGE: \

Rules are operating under the hood to choose among the possible
configuration choices and they may be biased toward the low resolution
end of a range because less 12m time is needed. Variations in the range

can cause disproportionately large differences in the required time.

In the two cases only the upper end of a range changes, from 1” to 3”

Be careful that the OT is not making choices for you that you would not

project time summary to examine the choices the OT is making

make for yourself. Before submitting with a range, narrow it and use the



Time constrained observing

-
RgT Project - Observing Tool for ALMA, version Cycle2Test2

File Edit View Tool Search Help |Perspective1
[8]n] [¢[m] [=]d] @+ /6o (W [@]c]] 0]
Proposal | Program | | Spectral | Spatial | Control and Performance |
Unsubmitted Proposal || Do you request complementary ACA Observations? JYes @ No Suggest I -

¢ & Project

? i Proposal Time Estimate
¢ [ Planned Observii

? ‘ ScienceGoal

[ General
[ Field Setup . .
Are the observations time-constrained? ® Yes ) No ® Specific Dates ) Multiple Epochs () Continuous Monitoring
D Spectral Setup
[ calibration Setu Number of time windoy/s specified : 1 /
[ Control and Per Start DajfTime (UTC) End Dat€Time (UTC)

(3 Technical Justif . S 20131003 13, / 171 201}%8
Please specify one or more suitable time windows

for your observation

Your
0

< I | [»

Template library. Turn the keys on... [ X]
Y L - J1de Jrdry. U - =

Add l l Delet

¢ @ Proposal
¢ [ Planned Observing
g4l ScienceGoal (B 56789
ScienceGoal (B
ScienceGoal (B
ScienceGoal (B9
ScienceGoal (B
ScienceGoal (B
ScienceGoal (B6
ScienceGoal (B
ScienceGoal (B6
ScienceGoal (B

Contextual Help




The sensitivity calculator is available separately in the OT (or on the web) A B

ALMA Observing Too 2017) - Chan Dark Neutral Matter (2016.1.00714.S last submitted 2016-08-30 10:29:
file_Edit * Menu or Button
| p—— 1 - -
@ 2 ALMA LO Configuration Tool... Eﬁl ©f @@ @
Project Structur i sensitivity Calculator... ~
Program | Tectal " Spatial_ | Control and Performance |
The > e il 000 Sensitivity Calculator i
- Chamgleon‘s Dark Neutral Matter se para are U Common Parameters s =
¢ [ Science Plan Control and Performance=> Dec 00:00:00.000] -
¢ (% ScienceGoal (Chameleon's dark neutr — 2]
[) General Configuration Information Polarization Dual h E
[y Field Setup Antenna Beamsize ( 1.13 * Observing Frequency 345.00000 GHz v
[) spectral Setup Number of Ant Bandwidth per Polarization [7.50000 GHz v -
— umber of Antennas
[) Calibration Setup Water Vapour ® Automatic Choice () Manual Choice -
% (T:°“:|’°' aI’;d P:r'f""“a"" Column Density 0.913mm (3rd Octile)
echnical Justification
. Trx, tau, Tsk 75 K, 0.158, 39.538K
% [&) SG OUS (Chameleon's dark neutra Longest baseline :
¢ [&) Group OUS _ _ Tsys 157.027 K
¢ [& Member OUS (1723-7713 Synthesized beamsize Individual Parameters
? @11?2 3-77_a_03_TMI1[L ST e 12m Array 7m Array Total Power Array
" Group 1 : Calibrator Number of Antennas |43 |10 |3 |
Group 2 : Science Maximum recoverable scale| Resolution 0.00000 arcsec | v ||5.97455 arcsec | v | 16.9 arcsec
? @ 9 Targets ) - N
® query Pointing Te Desired Performance Sensitivity (rms) 0.00000 uly w | (0.00000 uly A4 |0.00000 I uly v .
© query Pointing T¢ Desired Angular Resoly ~ (equivalentto) ~ Unknown K ~| 0.00000 K ~ | 0.00000 K v
® query Amplitude
@ query Phase (Ph Integration Time ~ |60.00000 s v||60.00000 s ~(/60.00000 s v
® query Bandpass N . ) -
® [R] [D2]J1723-7 Integration Time Unit Option |Automat|c |v|
® J1550-8258-40 Largest Angular Structu
0 J1617-7717-16) Sensitivity Unit Option |Automatic |v|
©)1733-7935-11 Desired sensitivity per
¢ [C]Resources Calculate Integration Time ‘ I Calculate Sensitivity ‘ I Close I
2 @ 9 Field Sources
[ Pointing Tem ® A valid sensitivity must be entered in order to calculate an integration time
) sensitivity mu g .
[y Pointing Tem Bandwidth used for Ser
[ Amplitude qu _ _
[} Phase query Science goal integratio )
[ Bandpass qu Override OT's sensitl
[ primary: J172 time estimate (must b
D Primary: J159 Are the observations
D Primary: J161
D Primary: J173
¢ @ 2 Instrument Set
[y B3 Pointing
[y HCN v=0 )=




__Tech Justification

ALMA Observing Tool (2014.6) - Observing Tool for ALMA Cycle3 Groundhog Day Test

Elle gdlt View Tool Search Help

[8]a]a[e] [<]s] [o[a]

& (@] =l o)

| Perspective 1

Project Structure : Editors
( Proposal “Program | Spectral [ Spatial l Technical Justification I

¢ (& Observing Tool for ALMA Cycle3 Ground
¢ @& Proposal
¢ [CJ Planned Observing

? ScienceGoal (Science Goal)
[ General
[ Field Setup
[ spectral Setup
D Calibration Setup

D echnical Justrﬁcanon

< I [ »

¢ (& Template library. Turn the keys on th{~|
¢ & Proposal

? m Planned Observing
i ScienceGoal (B3 spectral sy
ScienceGoal (B7 continuum
ScienceGoal (B7 CO(9-8): (
ScienceGoal (B9 continuum|=
ScienceGoal (B3 spectral sJ
ScienceGoal (B3 continuum
ScienceGoal (B6 continuum
ScienceGoal (B7 continuum
ScienceGoal (B6 continuum
ScienceGoal (B3 continuum| |
ScienceGoal (B6 12CO (2-1
ScienceGoal (B6 13CO (2-1
ScienceGoal (B6 spectral li
ScienceGoal (B9 spectral lij
ScienceGoal (B3 continuum

?

LA A A A A O 4

M . ol iD

T EmDE

<]

Template library. Turn the keys on the JTr... IX]

a2

Enter a Technical Justification for this Science Goal, paying special attention to the parameters reproduced below.

A sensitivity

Requested RMS over 2.4414062500000005E-4 GHz is 3.00 m)y For a peak flux density of 30.00 mJy , the achieved S/N is 10.0

Achieved RMS over the total 351.56 MHz bandwidth is 111.80 u)y For a continuum flux density of 100.00 mJy , the achieved S/N is 894.4

For a peak line flux of 30.00 m)y , the achieved S/N over 1/3 of the source line width ( 30.00 km/s /3 = 10.00 km/s ) is 26.1

Line width / bandwidth used for sensitivity 30.00 km/s / 731.92 m/s = 40.99

Dynamic Range: 33.33
Justify your requested RMS and resulting S/N for the spectral line and /or continuum observations.

For line observations also justify the bandwidth used for the sensitivity calculation.

N

There are separate standard sections for Sensitivity, Imaging and
Correlator and another may appear to allow you to justify some of
the parameter choices you may have made
Each requires its own 50+ word justification

Each standard section comes with a summary of the requested input

ScienceGoal (B6 continuum|— |
=~

information to detail the different technical aspects of your programj

[»

[

4]

| A
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Tech Justification

File Edit View Tool Search Help

[ajnjaja) (<= []d]

Perspective 1

Project Structure

“Proposal [ Program |

WA

EIBE
Editors

Spectral | Spatial | Technical Justification |

¢ @& Proposal
¢ [ Planned Observing
? ScienceGoal (Science Goal)
[ General
[ Field setup
D Spectral Setup
[ calibration Setup

echnical Justification

¢ [& Observing Tool for ALMA Cycle3 Ground

[y control and Performance

(!

|

»

Template library. Turn the keys on the JTr... |X

¢ & Proposal
¢ [ Planned Observing

5l ScienceGoal (B3 spectral sy
&3] ScienceGoal (B7 continuum
228 ScienceGoal (B7 CO(9-8): (
€3] ScienceGoal (B9 continuum
53l ScienceGoal (B3 spectral sy
il ScienceGoal (B3 continuum
22l ScienceGoal (B6 continuum
M ScienceGoal (B7 continuum
22l ScienceGoal (B6 continuum

?

22l ScienceGoal (B6 12CO (2-
i ScienceGoal (B6 13CO (2-
52l ScienceGoal (B6 spectral li

¥ ScienceGoal (B9 spectral Iilr]
22 ScienceGoal (B3 continuum
5l ScienceGoal (B6 continuum

2 Lin

L A A A A A A

¢ [ Template library. Turn the keys on th |

4 ScienceGoal (B3 continuum| |

-

| |

Imaging‘)

Requested angular resolution : 1.10 arcsec

Requested largest angular scale : 1.00 arcsec

ustify the chosen angular resolution and largest angular scale for the source(s) in this Science Goal

Here would be the standard required justification of
the imaging parameters

ACA is not recommended but is selected.
ustify over-riding of the OT recommendation for the ACA

Exceptions to standard practice require separate
justification. Here, the OT notes that the ACA is

selected even though the OT thinks it is unneeded.

Correlator configuration

line width / representative spectral window resolution: 30.00 km/s / 731.92 m/s = 40.99

Representative spectral window width : 702.64 km/s

Justify your correlator set-up with particular reference to the number of spectral resolution elements per line width.
You may want to consider spectral averaging to lower the data rate

Here would be the regular required correlator justification

| »

[




When the time is ripe ... validate & submit

Iﬂ'Project-ObseNingToo for ALMA, version Cycle2Test | el |

Bxn . —
ERC

- Perspective 1
[2) New DDT Proposal #-D

-

Open Project
Open Project as New Proposal )
|o] Save #-S
Save As...
4 Show ALMA Template Library
Use Project as Templat
Validate #®-L
Submit Project

2]

SelectPI...

(2]

Project [
Assigned Priority
Project Code MNone Assigned

Preferences
Save Preferences

Quit ="

fValidation r Validation History r Log |

| Description | Suggestion

Contextual Help

1. Please ensure you and your co-Is are registered with the ALMA New
Science Portal Science

2. Create a new proposal by either: Proposal

@ Selecting File > New Proposal
@ Clicking on the & icon in the toolbar
@ Or clicking on this link
3. Click on the @& proposal tree node and complete the relevant
fields.

Click on the overview steps to view the contextual help

P
Temnplate Meed

Library More
Help?

Importing
And
Exporting
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File Edit View Tool Search Help

Proposal | Program |

Blajnja) <= o/

Spectral | Spatial [  ScienceGoal (Science Goal) |

? Observing Tool for ALMA Cycle3 Grou
? & Proposal
¢ [ Planned Observing
? H ScienceGoal (Science Goal)

[ General
[ Field Setup
[7) spectral Setup
[ calibration Setup
[Ty control and Performanc
[Ty Technical Justification

< i | [»

Template library. Turn the keys on the J... Z
¢ [ Template library. Turn the keys on |4
¢ & Proposal
¢ [ Planned Observing

&N ScienceGoal (B3 spectral
ScienceGoal (B7 continuu
ScienceGoal (B7 CO(9-8)
ScienceGoal (B9 continuu =
228 ScienceGoal (B3 spectral
ScienceGoal (B3 continuu
ScienceGoal (B6 continuu
ScienceGoal (B7 continuu
ScienceGoal (B6 continuu
ScienceGoal (B3 continuu[ |
N ScienceGoal (B6 12CO (2
ScienceGoal (B6 13CO (2
ScienceGoal (B6 spectral
ScienceGoal (B9 spectral
ScienceGoal (B3 continuu|
ScienceGoal (B6 continuu:

. P Cmml iDL

?
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ALMA Observing Tool (2014.6) - Observing Tool for ALMA Cycle3 Groundhog Day Test

Perspective 1

Source Coordinates

Source Radial Velocity

Target Type
Expected Source Properties

Peak Continuum Flux Density per Bea
Continuum Polarization Percentage

Peak Line Flux Density per Bea

System (2000 |+

SEXAYESTTIT
display?

RA 22:02:43.2912

Dec -42:16:39.978

® Individual Pointing(s) () 1 Rectangular Field

Line Width

Line Polarization Perce

Field Center Coordinates

set

0.00000

[0.0 3
0.00000
0.00000

[0.0 |%

|arcsec

|v|

Dec [arcsec)

0.00000

0.00000

Parallax [0.00000 [mas |~
PMRA [0.00000 :
PM DEC [0.00000 :

[0.000 [km/s || [hel [+] 2[0.000000000] Doppler Type [RELATIVISTIC | v |

| »

[ validation/|  Validation History | Log |

9 errors, (fwarnings

Description

Suggestion

[X] Nofrincipal Investigator specified

Select the top level Project node in the tree and fill in the Principal Investigator field -

N¢/ scientific category defined

Select Proposal node and set a scientific category

Mo document found - you must add a Science Case to your proposal

Select the proposal node in the Proposal tab and add your document

ust select a minimum of 1 science keywords

Select the Proposal node and then add some science keywords (minimum 1

[x]
[X]
[X]
[x]
[x]

Either a continuum or a line polarization percentage is required for

Select the Target Parameters (anti-bllac) in the Science Goal and enter a valid value

Select the Target Parameters (anti-bllac) in the Science Goal and enter a valid value




When the time is ripe ... validate & submit

AT Project - Observing Tool for ALMA, vers

T

ion Cycle2Test:

—
= fah X

[ Perspective 1
[2) New DDT Proposal %D hmy @ @
Open Project | o
Open Project as New Proposal (N " |/ Spectral rspatim rprojed |
lo| Save -5 A Principal Investigator
Save As... 2
4 Show ALMA Template Library
Use Project as Template v |
Main Project Information
Validate #-L 7
Submit Proj Project I
Assigned Priority
Preferences Project Code  None Assigned
Save Preferences
QUit bt AR
|
Sugagestion
B R R A RNENNNNRNNNNRNNNNRNENRRRERERREREREE. R

Contextual Help

1. Please ensure you and your co-Is are registered with the ALMA
Science Portal
2. Create a new proposal by either:
@ Selecting File > New Proposal
@ Clicking on the £ icon in the toolbar
@ Or clicking on this link
3. Click on the @& proposal tree node and complete the relevant
fields.

Science
Proposal

Click on the overview steps to view the contextual help

P
Importing Temnplate Meed
And Library More
Exporting Help?




Use preferences to customize

DAD. Preferences
Appearance | Colours | Dialogs | Connection | Advanced |
e ) [t ze ® 00 Preferences
O] L EOnESHE ( Appearance | Colours [|Dialogs | Connection | Advanced |
File| Edit View Tool Search Help [ Mouse-over Tooltips - Science Goal Summary View——————— - Colours
en looking at a Science Goal, show ... . . .
B New - 32_N Show for secs. O a summary table General—' Spectral Display
£ @ all its page editors - Clipboard - Baseband
[} New DDT Proposal #&-D i ey - e — B Error I spectral Window
; When putting the cursor into a form field, ... [ warning [ Averaging Region
a New Pl’ogl’am Preferrably show editors @ select it (for easy overwriting) [ Phasel I suppressed Windows
r’ New Commissioning Program L O don't select it (for easy inserting) [ Phase2 I Rest Frequency
- rPerspective DDT Centre Frequen
Open Project v T L = i
- . 5 B fov [ catalog Lines
|=| Save #-S [ Fov 1/3 HPBW | | [ Sidebands
Save As... [ ] sidebands(Unconfigured)
: - 3 ~Look and Feel I Transmission Spectrum
=i Show ALMA Template Library I
imbus
Use Project as Template » eno Preferences
i /Appearance Colours 'Dialogs Cdnnection rAdvanced
@ Validate 3t-L i i i “ i rWanted Dialogs
. i Cancel Apply oK [ Dialog
Submit Project (All Others) -
: - 18006 ——Biaforence; Add.Confirm
Submit PrOjeCt as New ! ("Appearance | Colours | Dialogs| [ Connection | Advanced | gzﬁf&f&mﬁhanges
rUser Authentication Display field source name resolution information
Preferemes | _ Display initial start-up options
ALMA ID hliszd | _Search Display offset coordinates reference system change message
Qu it Display sky coordinates reference system change message 3
Password |"“"“ | Display velocity reference system change message

Editor.UnexpectedError

Export to file. Overwrite existing file?
ExportProject.OverwriteFile
ExportSB.OverwriteFile

Exporting to file. Coordinates out of range —
Exporting to file. Ignoring unsupported coordinates
Exporting to file. Invalid coordinates

Exporting to file. Problem while writing file

IAU lookups are not advised
Import.ConfirmConversion
Import.Overwritelnvestigators
Import.SaveCurrentProject

NetworkService.offline

Notify the user that basebands have been re-ordered
OT Version Check

PointingPatternEditor.OverwriteFile

Server URL https://ote.alma.cl/cycle-3/

Show Permissions...

 Connection to Project Repository

Location of Service |https://ote.alma.cl/cycle-3/ | vl

Please note that changes to this setting will not be remembered. Switching
to a different https-service is not possible, unless it is an official ALMA server.
If you need any of the above, talk to the computing support group.

NENEEEEEEEEEEEEEEEEEERERIE

4]

Cancel || Apply || OK |

I Cancel H Apply H OK |




Don’t be afraid to ask for directions

® @ AL
File Edit View Tool Search | Help

TliD! [ =|E 4 User Manual
Reference Manual F34€
Project Structure -~

" Proposal [ Program About...
Release Notes

[ ] [ ] About the ALMA Observing Tool
0 Lo FCactina | inkht an Chamealaan'c Nark 0

ALMA OT Release Notes for Cycle 6 Release

L ]»

Summary list of the key new capabilities, features and improvements since
Cycle 5 Phase 2. For the major changes please consult the Proposer's Guide
for more details.

1. As circular polarization will be officially supported for Cycle 6, the
user is requested to enter the expected level of circular polarization,
for continuum and/or spectral line. As with linear polarization, a
limit is enforced below which a validation error will be triggered.
New circular-polarization fields have been added to the ASCII input
format.

2. Band 8 1s now a standard mode. This means that it can now be
requested for the Stand-alone ACA.

3. The IF bandwidth of Band 6 has been increased by 0.5 GHz. This
will make it easier to observe CO and 13CO simultaneously.

4. Data rates are now calculated for 50 antennas. This is to ensure that
the SB will not fail at execution time.

5. Projects that require long baselines will use a smaller clustering
length (1 degree) as the phase calibrator must be quite close to the
science targets.

&. There is no longer a separate coordinate system associated with

] About ALMA l About the OT Il Release Notes |
. Acknowledgements l Credits l License l Version I

Close

4]
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Proposal | Program

Field Setup |

| Perspective 1

? lw Casting Light on Chameleon's Dark \CO
¢ [ Proposal
¢ [ Planned Observing %
¢ | ScienceGoal (Chameleon's daNk (|
[ General i
[ Field Setup
[ spectral Setup
[ calibration Setup
[ Control and Performance
[} Technical Justification

@ About the ALMA Observing Tool

| »

Choose

Source C

Source R

Target T

Expecte

Field Cel

ALMA OT Release Notes for Cycle 6 Release

Summary list of the key new capabilities, features and improvements since Cycle 5
Phase 2. For the major changes please consult the Proposer's Guide for more details.

1. As circular polarization will be officially supported for Cycle 6, the user is
requested to enter the expected level of circular polarization, for continuum
and/or spectral line. As with linear polarization, a limit is enforced below
which a validation error will be triggered. New circular-polarization fields
have been added to the ASCII input format.

2. Band 8 1s now a standard mode. This means that it can now be requested for
the Stand-alone ACA.

3. The IF bandwidth of Band 6 has been increased by 0.5 GHz. This will make
it easier to observe CO and [3CO simultaneously.

4. Data rates are now calculated for 50 antennas. This is to ensure that the SB
will not fail at execution time.

5. Projects that require long baselines will use a smaller clustering length (1
degree) as the phase calibrator must be quite close to the science targets.

&. There is no longer a separate coordinate system associated with rectangular-
field definitions. The source coordinate system will be assumed.

7. FITS files in Galactic coordinates are now handled correctly.

v
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About ALMA L About the OT I
Acknowledgements LCredits LLicense LVersion |

Release Notes

Close

l Add H Delete “ Reset “ Import H Export I

Add Source ” Load from File...

” Export to File... || Clone Source H Delete Source H Delete All Sources
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A Few OT Tips...

- dila

 The same cut and paste commands you use outside the
OT for text also work inside it since Cycle 5

« Ctrl-Z global shortcut will expand out all succeeding
items in the J-tree (try it, you’ll see what we mean)

* Holding down ALT when making choices in dropdown
lists will convert to the unit or type of the new choice
« Otherwise, only the description changes, not value

« OT does galactic-celestial conversion automatically
« Cannot convert in other ways, eg not FK5 J2000 to
ICRS. FK5 J2000 now deprecated

. 000000



A Few More OT Tips...

* NEW In the J-tree: Holding down the alt key in
combination with the up/down arrows will move from a
node in one SG to the same node in the adjacent SG (try
it when you have more than one SG)
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Atacama Large Millimeter/submllllmeter Array

1search of our Cosm

[— . FA— a
\; About Science Proposing Observing Data Processing Tools Documentatiom  Help Search Site Jo)

Observatory News NRAO News Status
Announcement of 3mm VLBI in Cycle 7 Multi-Messenger Astrophysics: Insights from Combining ) . .
Jan 07,2019 Gravity and Radio Waves Conﬂguraltlon Scngdgle .

Feb 16, 2019 Cycle 6 Highest Priority Projects
ALMA Cycle 7 Pre-Announcement
Dec 19, 2018 ALMA Data Reduction Party

Mar 13, 2019
Job Opening: Head of ALMA Department of Science o
Operations New Horizons in Planetary Systems Refereed publications: 1309
Dec 05, 2018 May 13, 2019

Last observed source:
Northeast_Section_of NGC6334
Current configuration: C43-1

More... More... More...

Science Highlights - An ALMA Detection of the Radioactive Molecule 26AIF in a Stellar Merger Remnant.

Although diffuse Galactic gamma-ray emission from the isotope of aluminum, 26|, was first detected in the 1980s, the
identification of the source of emission has been hard to pinpoint due to the poor spatial resolution of gamma-ray
observations. In a recent Nature paper, a team led by Dr. Kaminski has made use of sensitive, high-resolution observations
with Band 6 and the newly commissioned Band 5 on ALMA, as well as observations with NOEMA, to detect millimeter-wave

emission from an isotopologue of aluminum monofluoride (26AlF) towards the stellar merger remnant CK Vul (aka Nova 1670;
see Figure). These observations have provided information about the nature of one of the stars in the merger. l.e., in the case

— of CK Vul, the 28All is likely produced within a star with an initial stellar mass in the range of 0.8-2.5 M, that has already

| A ES CICTICE I i et
1110 & haca in malecules other than 2°AlF. and in solids.
ALMA Science Portal @ NRAO




|I could use a hand...

Have no fear, the ALMA Helpdesk is here...

Submit a Ticket

My Tickets

Account

2 My Profile
T s
E:

Knowledgebase  News  TOO

What can we help you with?

Latest Updates

We've got nothing to display here

Advanced Preferences

1: Tickets @ KB articles @ Science Porta

0=

Advanced Preferences



For more info:

https://almascience.nrao.edu/

The Atacama Large Millimeter/submillimeter Array (ALMA), an international astronomy facility, is a
partnership of Europe, North America and East Asia in cooperation with the Republic of

Chile. ALMA is funded in Europe by the European Organization for Astronomical Research in the
Southern Hemisphere (ESO), in North America by the U.S. National Science Foundation (NSF) in
cooperation with the National Research Council of Canada (NRC) and the National Science Council
of Taiwan (NSC), and in East Asia by the National Institutes of Natural Sciences (NINS) of Japan in
cooperation with the Academia Sinica (AS) in Taiwan. ALMA construction and operations are led on
behalf of Europe by ESO, on behalf of North America by the National Radio Astronomy Observatory
(NRAO), which is managed by Associated Universities, Inc. (AUl), and on behalf of East Asia by the
National Astronomical Observatory of Japan (NAOJ). The Joint ALMA Observatory (JAO) provides
the unified leadership and management of the construction and operation of ALMA.




